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Getting Started

Almost everything you’ve read about formatting pictures for Kindle is wrong.

Because of the variations, quirks, and deficiencies among different models and versions of Kindle, it is not the optimum platform for presenting pictures. Still, if your expectations aren’t too high—and if you are willing to ignore the advice of most Kindle formatting experts and of Amazon itself—it can do an acceptable job.

To work with pictures, you’ll need a photo editor like Photoshop, Photoshop Elements, Corel PaintShop Pro, Pixelmator, or Gimp. For Kindle-only publishing, Photoshop Elements should do fine. Besides having everything you’re likely to need for Kindle pictures, it maintains the legendary quality of the Photoshop brand, is far less intimidating than its parent program, and is very reasonably priced. You can also find lots of help for it.

For publishing that includes print, Photoshop—not Elements—is no doubt the most capable program you can find. It now comes in two versions. Photoshop CC—Creative Cloud—is the current and most advanced version but is available only by subscription. Photoshop CS—Creative Suite—is the preceding version, still available for outright purchase. That is what I originally used for work on this book and is what I’ve most heavily featured in it.

When I talk about Photoshop without distinguishing the version, I’m talking about CS and
 Elements—and usually CC as well, though notes on differences will have to wait for a future revision. Specific versions I discuss are Photoshop CS6 and Photoshop Elements 11. Though most of the screenshots here are taken from Photoshop CS, you’ll usually find a similar dialog box in the Expert mode of Photoshop Elements.

By the way, don’t be fooled about this book’s coverage by the name Photoshop, or by it commonly being called a photo editor, or by my many example photos. This book is not
 just about photos, or even primarily so. Photoshop is the stalwart of graphic artists, art directors, illustrators, and photographers alike. The techniques I describe are ones I’ve learned from using it for everything from photos to illustrations for my own children’s picture books. If photos make up the bulk of my examples, it’s only because I’m no illustrator myself, while I can use my own photos without permission!

In writing this book, I’ve tried to assume that you know little or nothing about dealing with pictures. So, I start by explaining basic properties like format, resolution, and color mode, and then provide a basic course in picture editing. I also give tips on getting the best results from your camera or scanner.

Many of you will want to include pictures in Kindle books that you compose in Microsoft Word. That may well be the most treacherous program you could use for this purpose—but I’ll show you how to do it safely and keep Word from degrading your pictures. (To make sure I got it right, I composed this book in Word.)

Kindle books are built from HTML—the common language of Web pages and ebooks—along with its companion language, CSS. This code provides instructions that help define how pictures in your Kindle book are displayed. So, for those of you with suitable software, workflow, and skills, I’ll also give tips on how to optimize your code for pictures on Kindle.

My focus here is on pictures used to illustrate a book with flowing text
 —text that adjusts its layout to different screens and also to different font sizes, margins, or spacing chosen by the user. But Amazon offers another kind of book as well: fixed format.
 In this kind, each page has a static layout and is simply reduced or enlarged to fit the screen.

Though there are disadvantages to fixed format, it may in some ways be the better choice for books featuring pictures more than text. So, toward the end of this book, I discuss a couple of specialized programs you can use to produce Kindle books of this kind, including the Kindle Comic Creator. It’s not just for comics!

Other topics of special interest include tables, screenshots, transparency, children’s books, poetry, cover images, and how to submit your picture files to Amazon KDP.

If you’re reading this book on Kindle, then the pictures themselves will show you the results of my techniques. For those of you reading a PDF or print version, I’ve done my best to emulate the appearance of the pictures in the Kindle book. With an EPUB version, you should still get the general idea, but keep in mind there may be differences in display.

For updates and related materials, please visit my Publishing Page at


www.newselfpublishing.com


While there, be sure to sign up for my email bulletin, so you’ll know when I have anything new, including revisions of this book. And though I’m not able to provide technical support or consulting, I’m always glad to receive comments, as well as suggestions on how my books might be improved.
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PLEASE RESPECT

COPYRIGHT!



If you are not sure

you have the legal right

to use a picture

in your Kindle book,



DON’T USE IT!
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1

Picture Basics



File Formats

Amazon accepts several picture formats, but the two most likely to be useful to you are JPEG and GIF.

JPEG (pronounced JAY-peg) is best for photos, paintings, and other art in which colors blend smoothly. GIF (pronounced JIF) is best for cartoon art, logos, line drawings, tables, and other graphics with areas of uniform color and strong lines or text; and also for pictures that require transparency. (But if your picture is already in the wrong format, it’s not a good idea to convert directly from one to the other, as this will just make it worse!)

Contrary to what you may have been told, JPEG is not a “better” format, with smaller file sizes. JPEG and GIF are each better at compressing the kind of pictures they’re designed for. Take, for example, the following two versions of the same photo.

First is a JPEG of medium quality, at a file size of about 29 KB.
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Now the same photo as a GIF, at about 74 KB.
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In this case, yes, the GIF is the loser at over twice as big. This is what you’d expect, because the JPEG format was designed primarily for photo compression. What’s more, the sky in the GIF shows banding,
 even on tablet or desktop Kindles that would otherwise show the colors blending seamlessly.

But take a close look at the following two versions of a cover image. The JPEG is again first, this time at a file size of about 20 KB.
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And now the GIF—at about 14 KB!
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For this picture, the GIF is only two-thirds
 the size and the color is smoother, without the irregularities shown by the JPEG! (You might not see those irregularities on an e-ink
 Kindle or without zooming in.) Of course, you could fix the JPEG by producing it with less compression, but then the file size would balloon.

In Photoshop, you can save JPEG or GIF from any other picture format with the Save for Web command, which also provides handy ways to adjust and optimize your pictures. I’ll be saying much more about this command as we go along—but in case you’re not at all familiar with it, here’s just a quick glimpse at the dialog box in Photoshop CS6.
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Though both JPEG and GIF are established standards, there is a good deal of legitimate and illegitimate variation in how different software programs implement them. This can cause compatibility problems. So, if you find your pictures rejected by the Kindle converter or another program, you might try importing them into a different photo editor and resaving.

That’s one advantage to using industry-standard software like Photoshop: You know that any other software will have been tested to read its files.

•

The Kindle converter accepts several other picture formats, but there some gotchas. BMPs are accepted as is, as long as they’re 8-bit
 or below and stay within the general file-size limit for Kindle pictures (which I’ll discuss later). PNGs are accepted but converted to GIFs—as long as they’re 8-bit
 , within the size limit, and don’t include transparency. Any BMPs or PNGs not
 meeting these criteria are converted to JPEG.

Among other things, this means you cannot get transparency from a PNG, as is commonly done on the Web. Though the Kindle converter will accept
 a PNG with transparency, that transparency will be discarded in the conversion to JPEG. (That’s what Amazon really means when it says it does not support transparent PNGs. You can include them, but they won’t work as desired.)

This may cause trouble if you compose your Kindle book in software that favors PNG over GIF for export. If you’re inserting transparent GIFs, make sure they’re not
 being converted to PNG. In Word, that means going into Web Options and making sure the option is not
 selected to “Allow PNG as an output format.”

The main thing to understand about BMP and PNG on Kindle is that, unless you already have a number of pictures in one of those formats, there’s no good reason to choose either one of them. Any time your choice is respected by the Kindle converter, a GIF would do just as well. Any time BMP or PNG would
 have an advantage, the picture is changed to a JPEG.

So, for simplicity and reliability, I suggest you stick to JPEG and GIF, and I won’t say much more about the other two.

The only other format accepted on Kindle is SVG—Scalable Vector Graphics. This is an advanced illustration format related to PDF and EPS. Though it offers great flexibility and compact file sizes, it won’t show up at all on older Kindles. So, this too I will leave aside.

•

When you assemble your ebook, some software will let you insert pictures in a wide variety of formats—including the higher-quality TIFF and PICT—for conversion on export. The problem is, you may have little or no control over that conversion. So, it’s generally best to insert GIFs and JPEGs you’ve created beforehand and see if the software will let them pass through untouched.

In any case, make sure you understand which pictures your software will translate to which formats, and what options you have, if any. For example, here’s how it goes in Word when exporting to HTML with PNG disallowed in Web Options:

• JPEGs always stay JPEG.

• GIFs remain GIF—as long as you follow the procedures I’ll recommend.

• Any other pictures with transparency become GIF.

• Any other pictures without
 transparency become JPEG.



Resolution

If you zoom in far enough on most digital pictures, you’ll see they’re made up of tiny squares of solid color. These squares are called pixels.


The pixels in a picture are allowed to be any size—as long as they’re not so big that you notice them at normal viewing distance. Because they’re so small, their size is most conveniently expressed as the number that can fit in a certain length—generally in pixels per inch (ppi). This measurement is called the picture’s resolution.
 So, if a picture’s pixels fit 72 to an inch, the picture resolution is 72 ppi—which happens to be the most common standard for pictures meant for the Web or for ebooks.

The display size of a picture—how big it appears—depends on two factors: its resolution and its dimensions as measured in pixels. Let’s say you have two pictures, and each one is 300 pixels wide and 300 pixels high. The first picture, though, has a resolution of 300 ppi, while the second is at only 75 ppi. The picture at 300 ppi, then, will be only one inch square, while the one at 75 ppi will be four inches square. Same number of pixels, but different resolutions, so different display sizes!

At least, that’s how it works in print, and that’s how it’s represented in photo editors like Photoshop. But on the Web and in ebooks, the specified resolution of the picture is ignored.
 That measurement is replaced by the pixel resolution of the screen—
 the number of pixels per inch that it displays.
 The higher the screen resolution, the smaller the pixels, and the smaller the picture will appear—if it’s not adjusted by some other factor.

So, the Kindle cares nothing
 about a picture’s resolution. The Kindle cares only
 about pixel dimensions. (This is despite Amazon’s own confusing recommendation to give pictures a resolution of 300 ppi to “future-proof” them. What Amazon means
 to say is that a picture should have enough pixels to display at the desired size on a screen with a resolution of 300 ppi.)

This unconcern with resolution, though, may not be shared by the software you use to produce your ebook. For example, Microsoft Word for the Mac wants your JPEGs to be at 72 ppi, the default for Web graphics. Microsoft Word for Windows,
 on the other hand, wants them at 96 ppi. At least in later versions of Word, ignoring these preferences will get your pictures automatically resized. (More on that later.)

Now, there are times when you want to keep the resolution of a picture but change its pixel dimensions. And there are times when you want to keep the pixel dimensions but change the resolution. And there are times when you want to change both at the same time. You choose among these options when you resize
 the picture. For example, in Photoshop, you make such changes with the Image Size command, found on the Image menu. Here’s the command’s dialog box in Photoshop CS6:
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First, type in your desired resolution, if it’s different from what’s shown. If you also—or instead—want to change the number of pixels, that’s called resampling.
 Check “Resample Image” to allow a change, or uncheck it to keep pixel dimensions unchanged.

If you’re resampling, go ahead and change the width and height, either in length or in pixels. It helps with this if you start with “Constrain Proportions” checked—but if you’re changing pixel dimensions and find you’re unexpectedly getting a length measurement with a lot of decimal places, uncheck that setting and round it off by hand. This can make things cleaner when you add the pictures to your book.

Resampling a picture generally makes it fuzzier. Though I’ll later discuss sharpening the picture as a way to counteract this, it’s still best to avoid resampling the picture more than once. In other words, once you’ve resized a picture by resampling, you don’t want to do it again. It’s better to go back to a version from before the original resizing and get it just the way you want in one step.


Note:
 Due to a bug in some versions of Photoshop, your change of resolution may be ignored by the Save for Web command until you close and reopen the picture.

 So, if JPEG resolution makes a difference to your software, be sure to check on it after saving with this command.

•

A common error among self publishers is to pull small graphics off the Web or from screenshots and stick them into a book as is. Because these graphics are normally at only 72 or 96 ppi, they often don’t have enough pixels for the higher-resolution screens of ebook readers, let alone for print. So, the picture may appear too small—or if you display it larger, the individual pixel squares grow big enough to be visible, in an effect called pixelation.


It used to be accepted wisdom that you could do nothing about this. But that assertion was based on early methods of picture enlargement. Though you can never add detail, you can
 smooth edges and make pixels invisible with a suitable enlargement method.

Going back to the Photoshop Image Size dialog box, check “Resample Image” and make sure the pull-down menu beneath is set for “Bicubic.” Unlike the old method, “Nearest Neighbor,” bicubic resampling calculates new pixels by weighted averaging of surrounding ones, providing real improvement to a low-resolution picture. With this method, you should be able to at least double your pixel dimensions with acceptable quality.

Photoshop offers several additional “Bicubic” methods—but despite their confusing names and descriptions, they all apply more automatic sharpening than plain Bicubic. So, I do not recommend them.

•

By the way, if you’re reading a printed
 version of this book, you may well see pixelation in some of my sample pictures that are not supposed to show it. That’s because they’re optimized to display on a screen. Pictures optimized for print would need to start at a higher resolution to keep the pixels from being noticeable.



Color Mode

The colors in a digital picture might be defined in any of several ways, and we call these color modes.
 Here are the modes you’re most likely to deal with when preparing pictures for Kindle, as those modes are named in Photoshop.


RGB.
 This is the basic full-color mode for screen display, as well as the most common color mode for JPEGs. It’s based on combining three colors of light—red, green, and blue. Mobile and desktop Kindles will display RGB as is, while e-ink
 Kindles will convert it to grayscale.


Grayscale.
 This is what we commonly call “black and white,” though it generally includes 256 levels
 —black, white, and shades of gray in between. A JPEG can be in grayscale instead of RGB, though this is not common. Grayscale is also the native mode of the e-ink
 Kindles—but on these, the highest number of levels is 16!

A picture with black, white, and grays could be rendered in RGB instead with no visible change, but the grayscale mode gives a much smaller file size in most picture formats. This advantage disappears, though, in JPEG, where both color modes produce files of virtually the same size. So, for the Kindle alone, there’s no need to keep such a picture in grayscale.


Indexed color.
 This is the color mode used by GIFs and 8-bit
 PNGs. (For PNG-24
 , the mode is RGB.) This mode is limited to just 256 colors, but those colors, specified within the picture data, are automatically selected to best suit the individual picture. For example, if you create a GIF from a picture of autumn leaves, its color table
 will include mostly reds, oranges, and yellows. An ocean picture will get a table of mostly blues and greens. A “black-and-white” photo will get only black, white, and grays.


Bitmap.
 This is the true
 “black and white,” with only those two colors present. (Don’t confuse this color mode with the Bitmap picture file format common on Windows. The names are the same, but there’s no other connection.) For the Kindle, a picture in Bitmap mode would normally be converted to a GIF with a two-color
 index.

Usually, you don’t have to worry about color mode, since saving to JPEG or GIF will automatically place your picture in a mode that’s suitable. Still, there are times you might want to convert from one mode to another. For example, if you open a GIF in Photoshop, many of the program’s editing commands won’t work until you convert from indexed color to RGB. Or a “black-and-white” photo scanned as RGB might show an unwanted color tint, which you can eliminate by converting to grayscale—even if you don’t keep
 the picture in that mode.

It’s simple to switch a picture’s color mode in Photoshop. Just choose what you want from the Mode submenu of the Image menu. (Note that, in Photoshop, a picture must be in grayscale before you can convert to bitmap, so you may have to convert in two steps to get there.) This submenu will also show you the current color mode, in case you’re not sure of it.

•

There’s one more color mode you’re likely to run into: CMYK.
 This is another full-color mode like RGB, but it’s used for printing instead of screen display. It’s based on combining four colors of ink—cyan, magenta, yellow, and black (K).

It used to be a good idea to convert pictures from RGB to CMYK and optimize them in that mode before sending them for printing. With technological advances, it’s now best to stick to RGB and let the press handle the conversion automatically. But you might have a picture already converted to CMYK that you want to use in your Kindle book.

Though you could
 just convert it back, the original conversion to CMYK probably removed all of the picture’s brightest colors, and it might never again look its best. So, it’s best to try to find an RGB version from before
 that conversion.

If you can’t, go ahead and convert the CMYK picture back to RGB. In Photoshop CS, again, you can do this from the Image menu. Photoshop Elements, on the other hand, does it automatically when you open the picture, since the program does not even support CMYK editing.



Color Space

Digital devices like computers, cameras, scanners, printers, and ebook readers define colors as values within a numerical range that is then matched to a range of colors. The problem is that the color range that can be handled by each device—its color space—
 is different. So, the same numbers translate to more or less different colors on different devices.

To allow for this, pictures are normally edited in one of a number of standard color spaces, and that space is identified in a color profile
 embedded in the picture itself. The device can then use that profile to accurately translate the picture’s colors to its own. This is called color management.


Unfortunately, in keeping with the Kindle’s general orientation toward low quality, neither Kindles nor the Kindle converter are color-managed. In fact, to guard against future improvements, the Kindle converter strips any color profile from your pictures! This wouldn’t be so bad if all Kindle color screens were made to come close to a standard color space, as many computer screens are. But that has been done only on the most recent, high-end Kindles. So, no matter what you do, your colors are guaranteed to be off on most color Kindles. Still, this doesn’t mean you can ignore color management yourself.

The following discussion gets pretty technical, and I know a lot of readers would hate going through it. (Personally, I find it fascinating!) So, let me say you probably don’t need most of it unless you’re planning a print edition of your book as well as a Kindle edition. If you’re working in Photoshop and publishing on Kindle only
 , here’s the short version instead:

On the Edit menu, choose Color Settings. In Photoshop CS, from the top pull-down menu, choose “North America Web/Internet.” In Photoshop Elements, choose “Always Optimize Colors for Computer Screens.” After that, always use the Save for Web command to create your JPEGs and GIFs, and in Photoshop CS, make sure you select the option “Convert to sRGB.”

•

There are two standard color spaces most useful to publishers today when preparing full-color, RGB pictures for various media. Not by accident, they’re also the spaces best supported by Photoshop.


Adobe RGB.
 This is the larger of the two spaces, and it encompasses most or all of the colors available from a commercial printing press. For this reason, it has become the standard RGB color space for the publishing industry. CreateSpace, for instance, prefers its pictures in Adobe RGB, and Lightning Source too will accept them.


sRGB.
 This is a much smaller space, representing the average color range you’d expect from a cheap computer monitor. It has become the standard color space of the Web as well as most ebook readers, because it’s a lowest common denominator. And because of that, it’s also the default color space for digital cameras and cheap scanners.

Which one of these target spaces should you choose for Kindle pictures? If you haven’t already guessed, it’s sRGB, the lowest common denominator. Some newer, higher-end Kindles are now made to match the sRGB space, while others are closest to that one. (It’s actually quite funny to watch Amazon bragging that their high-end Kindles match the color space of the cheapest computer monitors.)

So, we know we want our pictures in sRGB . . . But wait! What if the same picture will also go into a print edition of the book?

The fact is, we may want the same picture in different color spaces for different destinations. And you don’t want to just switch back and forth, because here’s the thing about color spaces: You can always condense the color range of a picture to fit a smaller space, but you can’t expand that range again.

For example, say that you convert your picture from Adobe RGB to sRGB. In doing that, you throw away any colors that don’t fit within the smaller space—and there’s no way to regain them. Sure, you can still convert an sRGB picture to Adobe RGB—and you should,
 if you only
 have it in sRGB and you’re preparing it for a POD press. But you’ll still have sRGB colors only, while the rest of the Adobe RGB space goes unused.

So, the rule of thumb is to edit the picture in the largest color space that’s available to you and that you’re likely to ever need. For a self publisher in print, that would normally be Adobe RGB. Unless your picture is already in sRGB—or you’re sure you’ll never need the picture for anything other than Kindle or the Web—save a version in the larger space before converting to JPEG or GIF as a final step for Kindle.

•

Now that we know what we’re aiming at, let’s look at the tools available to achieve it in Photoshop. For this discussion, we’ll have to deal with the CS and Elements versions separately, since they use different approaches.

In Photoshop CS, the first line of attack for color management is its Color Settings, on the Edit menu. These settings tell the program which color space you prefer for which color mode, and also how to handle pictures with profiles that don’t match that preference or are missing. Here’s the dialog box in Photoshop CS6:
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Use the “RGB” pull-down menu under “Working Spaces” to choose the largest color space your pictures will need. Or you can just use one of the presets on the Settings menu. “North America Web/Internet” will automatically choose sRGB, as is fine for Kindle-only publishing. “North America Prepress 2” will select Adobe RGB to accommodate print publishing as well. With the settings under “Color Management Policies,” you can also determine whether Photoshop will change a picture as needed on opening, leave it alone, or ask you what to do.

Based on these settings, Photoshop will now create any new RGB picture in the color space of your choice. It will also try to deal with a variety of possible situations when opening a picture.

For example, a picture’s profile might specify a standard color space that’s different from your preference, or one based on a particular camera or scanner or computer monitor. In this case, Photoshop can convert
 the picture to your chosen color space and embed a new profile. Conversion means shifting the color values in the file to their closest equivalents in the new space, including shoehorning any colors that fall outside that space entirely. The intent is to keep the picture looking as close as possible to the way it did before.

Or the profile may be missing entirely. Photoshop can then assign
 the profile you believe the picture should have. This embeds a new profile without
 changing the color values. Here, the intent is to embed a profile that makes the picture look as it should. Different profiles will get you different colors, and only a profile closely matching the original color space will make the picture look right.

Once the picture is open, Photoshop gives you the tools to make these same kinds of changes yourself. You can see the profile name in the Info panel; or by choosing “Document Profile” from the pull-down menu at bottom left of the document window. On the Edit menu, you’ll find the commands Convert to Profile and Assign Profile. Again, the first command involves changing the color values, while the second does not.

Why would you need to assign a profile manually when Photoshop can handle that for you on opening? Because the profile applied might be wrong. For instance, if an sRGB profile is mistakenly assigned to an Adobe RGB picture, it can look dull and lifeless. You can then try assigning Adobe RGB instead to see if that corrects it. Conversely, an Adobe RGB profile assigned to an sRGB picture can make it look garish.

As I said, a picture in Adobe RGB must be converted to sRGB before your JPEG or GIF is generated for Kindle. You can do that with Convert to Profile—but you don’t need to. Instead, let Photoshop do it for you automatically as part of the Save for Web command. In the dialog box, just tick off the option “Convert to sRGB.”

•

The color management tools in Photoshop Elements are simplified—and for that reason, they’re easier to set up and at the same time harder to use. (The following is based on Photoshop Elements 11.)

Elements too has its Color Settings command, which is likewise found on the Edit menu, but the options are very different from those of Photoshop CS and even less useful than they seem. The dialog box looks like this in Photoshop Elements 11:
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Of the options offered, “No Color Management” is, of course, no good at all. All it does is strip out any color profile it finds.

The next two options let you tell Elements which RGB color profile to use in several situations: when it assigns a profile to a picture that doesn’t have one; when it converts a file from an unsupported color mode, like CMYK; when you send it a picture from Camera Raw; and when it creates a new file. You basically have two choices. “Always Optimize for Computer Screens” gives you sRGB in all
 these cases. “Always Optimize for Printing” gives you Adobe RGB.

You might think “Allow Me to Choose,” the fourth option, would be best for providing control, but you’re only asked to choose for files with missing profiles. In the other cases, you automatically get sRGB. Not the most sensible approach!

What none
 of these settings offer is the option of converting
 a picture that has a profile already embedded. For that, you have to wait till the picture is open. At that point, in Expert mode, you can choose to see the name of the profile at the bottom left of the document window, as in Photoshop CS. On the Image menu, you’ll find commands to convert to either sRGB or Adobe RGB.

Just as Elements provides no way to convert a file at opening, it provides no way to assign
 a different profile after
 opening. If you think the wrong profile has been assigned, close the picture without saving or after using the Remove Profile command, then reopen it under different Color Settings. If a new, blank picture is in the wrong color space, you can just convert to the other space before doing anything else. (The white background will have the same value in any color space.)

As in Photoshop CS, you can make the final conversion to sRGB with the Save for Web command. Here, though, the conversion is enforced, with no option to turn it off, even if you choose not to embed the profile.

From all this, you might conclude that Elements is adequate for Kindle-only publishing but that Photoshop CS is a much better tool for also publishing in print. And you’d be right. Photoshop Elements does not even always properly color manage in displaying your picture. That makes it pretty unreliable unless you’re working entirely in sRGB.

•

So far, we’ve talked about color spaces and color management only for pictures in RGB. Things differ, though, for different color modes and more limited picture formats.

Pictures in indexed color occupy the same color spaces as pictures in RGB, and in the case of PNGs, color management is pretty much the same. The GIF format, though, doesn’t allow embedding of color profiles. So, keep in mind that every
 time a GIF is opened, Photoshop will assign
 a profile based on your Color Settings. Also, you can generally assume that any GIF is meant
 to be in sRGB.

Grayscale has its own set of color profiles—or actually, one set for screen display and another set for print. But as I said before, a picture with only black, white, and grays can be rendered in RGB as well as in grayscale mode, and there’s no file-size advantage to grayscale in a JPEG. So, grayscale is not that useful outside print publishing and fine-art photo printing.

For book printing, the typical default grayscale color space is called Dot Gain 20%. If you are planning a print edition, I suggest editing your grayscale picture in that space, then letting Save for Web convert to sRGB when producing your JPEG or GIF for the Kindle. For Kindle-only publishing, you could
 edit in grayscale if you like—Gray Gamma 2.2 would be the most suitable space for a new file—but you could also go directly to sRGB, where you want to end up.

True black-and-white pictures in the bitmap color mode do not have color spaces or profiles and don’t need them. On any kind of device, black is always the lowest color value, and white is always the highest.

•

One problem faced by many self publishers is that they try to edit their pictures on computer monitors that are limited in color range and wildly misadjusted. Then they wonder why their colors turn out differently in their books.

Though you don’t need to go to the extremes taken by a professional graphic artist, there are several things you can do to see more accurate pictures on your monitor.

• If your monitor allows it, turn down its color temperature
 to 6500K—the setting used by most publishing professionals today. Most monitors come with a factory setting of 9300K, giving their displays a bluish cast. (If you think that looks right, it’s only because you’re used to it.)

• Switch the light bulbs in your computer room to “natural daylight”—again, 6500K. Most bulbs have a much lower
 color temperature, giving a yellowish cast.

• Turn down your monitor’s brightness to where it’s just comfortable to view. Leaving it at a default 100% only strains your eyes and wears out the monitor.

• If you’re publishing in print, you may find it worthwhile to get a “wide-gamut” monitor, which will display most colors in the Adobe RGB color space. Remember, though, that Kindle graphics are not color-managed, and neither is most of the Web. When viewing pictures that lack color profiles, you may have to switch the monitor’s display mode to sRGB to make them look right!
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2

Picture Sources



Photography

Despite the wide variety in available cameras, almost any current model can take photos adequate for the small sizes displayed on Kindles. What’s more important than the camera is how you set it and how you take the photo. Here are a few tips.

• If you’re good at photo editing, then shooting in Raw format is your best option. But otherwise, just shoot in JPEG, at the largest size and highest quality available, and it will be just fine. You can mostly ignore old warnings about JPEGs quickly deteriorating when edited. Advanced photo editors like Photoshop now have ways to minimize that, so you could edit a large, high-quality JPEG on literally dozens of occasions before noticing a difference. But if it worries you, you can save as TIFF before editing.

• The default color space for a JPEG straight from the camera is sRGB, but more advanced cameras allow you to choose Adobe RGB instead. (Raw files do not have any defined color space.) As I said before, sRGB is fine if your photos are just for Kindle. If you might use them also in a print edition, use Adobe RGB instead, then edit in that color space and convert to sRGB only when you make final copies for Kindle. In Photoshop CS, the Save for Web command can be set to perform that conversion, while the same command in Photoshop Elements does it automatically.

• If you’re good at photo editing, you may want to keep manual control of some or all of your camera settings. But these days, the cameras are smarter than most of us, so feel comfortable to use an automatic mode.

• Turn off flash.
 That’s the main exception to using automatic settings.
 Using a camera’s built-in flash washes out colors and creates heavy shadows that are a sure sign of an amateur.

• Get closer or zoom in.
 Another sign of an amateur is the tendency to include too much in the photo. How many snapshots have you seen that take in someone’s whole body—right down to the feet—leaving the most important part, the face, almost too small to make out? To bring out what’s essential in your photo, you want only that part to fill the frame. Sure, you can crop out other parts later, but then you’re using less of the camera’s sensor, giving you lower image quality.

• Keep the camera steady.
 This is important with all cameras, but especially with those you must hold in front of you to look at a screen instead of putting your eye to a viewfinder. Do whatever it takes—stand with your legs spread apart and one foot forward, lean against a wall or post, sit or kneel, hold your elbows tight to your body or propped up on your knees or a table or a railing. Squeeze the shutter button firmly but gently so the camera doesn’t jerk. Most important, turn on whatever stabilization mechanism is in your camera or lens. You could instead use a tripod—but with built-in stabilization and a little care, that’s seldom needed.

• Watch your lighting.
 Cameras generally work better in more light, and more even
 light. Don’t place your subject in a shadow, and unless you’re trying for a special effect, try to make sure it’s lit from the front. Noonday sun, because of shadows and high contrast, is about the worst light you can get—short of having too little light at all.



Scanning

If your picture isn’t already digital, you’ll need to scan it to get it there. Luckily, almost any current scanner is good enough for Kindle publishing, including the scanner you might have on your inkjet printer. In fact, because LED lighting has replaced fluorescent in newer models, a cheap scanner of today can outperform an expensive one of yesterday in color accuracy and reliability, as well as in ease of use.

•

In case you haven’t done much scanning, here are some settings I recommend for reflective
 art—in other words, for anything but negatives and transparencies.

• I’ll be talking a lot more about resolution and sizing, so you’ll get a better idea of what you need as a scanning resolution. In general, though, you’ll judge this resolution based on how much you need to enlarge the picture.

If your photo or painting is full-size—that is, around 8 × 10 inches, or 8.5 × 11—and if it doesn’t require a lot of cropping, then a resolution of 300 ppi (or dpi) should be enough. If the picture is much smaller or needs much cropping, you might want to go to 600 or even higher. Line drawings need higher resolution to keep their lines smooth, so you might scan those at up to 1200.

Note that a scanner’s optimal resolutions usually fall in a pattern of halves—typically 1200, 600, 300, 150, 75—based on the scanner hardware. You’ll get better results if you stick to these resolutions. And don’t bother with ultra-high resolutions generated by incremental movements or the scanner software, beyond the scanner’s real optical capabilities. You’re not likely to need resolutions that high, and if you do, you can generate them as well or better in your photo editing software. If the scanner’s advertised resolution is 1200 × 2400, for example, consider 1200 its maximum.

The approach I’ve just described is adequate for most scanning. To get the very highest quality, though, always scan at the maximum optical resolution of the scanner—typically 1200. Otherwise, you’re scanning only points on the picture at intervals, rather than the whole thing. If the resulting file is too large, you can always downsample afterwards—for instance, with Photoshop’s Image Size command, using the Nearest Neighbor method and a resolution chosen from the pattern of halves for the cleanest, most accurate output.

• Some scanners will allow you a choice of color space. As with JPEG photos from your camera, Adobe RGB is best for output if you’re planning to also use your picture for printed books. For Kindle-only color, though, you can just choose sRGB—which is also what you can expect if your scanning software provides no choice.

• In some scanners, colors can be defined with a bit depth
 of either 8 bits or 16 bits in each of the three channels of RGB color. (These depths for each channel are sometimes added up and called 24-bit
 and 48-bit
 , respectively.) The higher setting allows the color range to be digitally divided into smaller steps, yielding smoother gradations.

Normally, 8 bits is fine. On a color scan, you won’t be able to tell the difference, and it will keep your file size from doubling. But if you expect to edit the picture heavily—say, by drastically shifting its colors or increasing its contrast—you might prefer to start out with 16, then downsample to 8 when that extreme part of the editing is done.

Also, 16 bits is best for scanning “black and white” photos and paintings. That’s because these pictures have only a single color channel, and 8 bits total does not really provide enough shades for smooth editing.

• Though there are reasons to accept a JPEG from a camera, the best format for picture editing is really TIFF, so that’s how you should save your scan. Converting to JPEG or GIF for the Kindle would then be the final step in your editing.

TIFF files are a lot bigger than JPEGs, but you at least have options for compression that can narrow the difference. Your scanning software may provide such options, or if not, you can find them in your editing software. In Photoshop, for example, you can Save As and choose among several compression methods .

Don’t choose JPEG compression for a TIFF. This will degrade the picture in the same way as saving in JPEG format in the first place. LZW compression is best for speed and for compatibility with older software (including Microsoft Word 2003/2004 and earlier). But don’t use LZW on a 16-bit
 scan, as it will make the file larger! Zip compression is slow and less widely accepted but will produce the smallest files and work fine with 16-bit
 color.

• Your scanning software may offer automatic functions for restoring or enhancing color, contrast, and/or sharpening. If you’re not good at picture editing, you might try these settings to see how you like them. Otherwise, you might get better results from your photo editing software.

•

Before being printed in a book or magazine, a photo or painting is broken up into rows and columns of tiny dots with white space in between. Or, in the case of full-color pictures, into four different sets of dots, each of the sets in a different, single color.

Though today that’s all done digitally, it used to be done by photographing the picture through a screen—literally. So, even now, we say such pictures are screened
 . Screen resolution
 is measured in lines per inch (lpi), equaling the number of rows of dots fitting in an inch. For “black and white” photos and paintings, these rows are diagonal and are counted that way. For full color, each set of dots is printed at a different angle, forming a pattern of rosettes.

To convert a screened picture into something you’d want to display in your Kindle book, you need to descreen
 it. That means merging the dots back into a continuous whole. Most scanning software includes this option. To make this work, though, you must have at least a rough idea of the original screen resolution.

Generally, the smoother the paper, the higher the resolution that was used. So, good starting guesses are 75 lpi for newspapers, and 150 lpi for books and magazines. You can then experiment with higher or lower settings, if you like. Or, if you scan a portion at 1200 ppi or so, you can magnify the view and actually count rows of dots.

Most descreening features, either in scanning software or photo editing programs, do their job by blurring the picture. This requires you to apply extra sharpening to compensate, either during descreening or after. (I’ll talk later about sharpening.)

Even with sharpening, though, you’ll lose some detail. If that seems a problem, you might look at Sattva Descreen. This Photoshop plug-in replaces blurring with a mathematical calculation of the pixels that should fill the gaps between dots. Though you can never regain the detail of the unscreened photo, this method at least loses less in descreening. Find it at


www.descreen.net


•

If you’re not seeing a scanning option you need, it may be because the scanner itself doesn’t support it. For instance, not every scanner provides 16-bit
 output, even if it uses 16 bits internally. You can check this by looking at the scanner’s published specs.

Other times, the problem is that the controlling software that came with the scanner does not take full advantage of its capabilities. For instance, the software might limit the color space to sRGB, even when the scanner’s internal color space is much wider.

Sometimes, you might find more advanced scanning software on the manufacturer’s Web site. Epson, for instance, offers Epson Scan, which does not always come in the box with its less expensive scanners.

Or you might turn to third-party scanning software. Nowadays, that boils down to SilverFast or VueScan.

SilverFast is aimed at high-end use. It’s pricey, and the version you buy can be used only with a single scanner model—if your model is supported at all. Find it at


www.silverfast.com


VueScan is less polished but priced much more reasonably, and it supports most flatbed and slide scanners right out of the box. Find it at


www.hamrick.com


Either program can produce fine results. Neither one, though, is easy to master or likely to win awards for its interface. Expect to spend a lot of time with the documentation or a third-party guide, as well as a lot of time experimenting.

•

If you’re scanning old photos, they may require quite a bit of touch-up to bring them up to quality standards. If you’re not skilled in that—or if there’s simply more of it needed than you’re ready to handle—there are services that will send your previously scanned image to countries where such work is more than welcome, and at prices that are affordable for those of us in richer countries. One such service I can recommend highly is ScanCafe, at


www.scancafe.com


Scans of slides and negatives should really be done in specialized scanners—and preferably not the cheap kind that are currently popular, which just take a new photo of the old. Unless you’re doing a lot of this work, it makes most sense to have it done professionally. One service I can recommend for its reasonable cost and professional options is ScanMyImages, at


www.scanmyimages.com
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3

Picture Editing



Cleanup and Repair

Typically, picture editing may start with general cleanup and repair of the picture. If it’s a photo straight out of the camera, it may need no remedial work at all. But if it’s a scan of art or an old photo, it will almost surely need something.

You can start by removing any white borders. In Photoshop, you can do this simply with the Rectangular Marquee tool—the dotted rectangle normally at the top of the Tools panel. Just drag the cursor to select the area you want to keep, then use the Crop command in the Image menu to remove the rest.

With this method, though, don’t try to trim all four edges at once. Start from outside
 the picture at one corner and drag to select all but the two edges meeting in the opposite corner. Crop out those edges, then drag from that
 corner to crop the remaining two. You may want to zoom in then and check the edges to make sure you’ve removed every bit of the white.

Alternatively, you can use the Crop Tool. This lets you move the individual edges of your crop box for careful adjustment.

Now it’s time to deal with any imperfections—white or black spots, scratches, stray lines, hairs, whatever. Photoshop has a number of specialized repair tools, but the most basic and versatile is the Clone Stamp tool, appearing in the Tools panel as a rubber stamp. Basically, it copies one part of the picture to another.

After setting the tool’s size and hardness in the tool options, position the cursor over the spot in the picture you want to copy from,
 then Alt-click or Option-click to set the point. Then go to the spot you want to copy to,
 and click and drag over the area. Note that, as your cursor moves, the source spot moves too, always maintaining its distance and direction from your cursor.

Any flaw you miss now could bug you later, so it’s worth taking time to perform this step thoroughly. Zoom in to 100% and scroll over every bit of the picture in overlapping rows or columns.

If you like to drive automatic instead of stick shift, try one of Photoshop’s Healing Brush tools. You can always go back to Clone Stamp if you need more control.

•

Though Photoshop is overall the most powerful photo editor you can get, this doesn’t mean its performance of each and every function is best in class. Sometimes the Photoshop engineers settle for “good enough” to avoid overloading computers and slowing down their customers. Other times, a function may languish while the developers’ attention is elsewhere. And still other times, a specialized function might be missing entirely.

Sometimes, then, it’s worth turning to third-party “plug-ins” to gain advanced capabilities. These add-ons plug into Photoshop and sometimes other apps, to be called from their menus. Some may be offered also in standalone versions.

For cleaning up pictures, I’ve personally found great value in plug-ins from Topaz Labs. These include DeNoise, to remove visual “noise” from digital photos and scans; InFocus, to correct pictures suffering from missed focus or motion blur; and DeJPEG, to remove artifacts created by excessive compression. While these plug-ins may work better with some pictures than with others, their effects can sometimes be magical. Find them at


www.topazlabs.com


•


Important:
 You should save a copy of your picture before you start work on it, then after cleanup and repair, and after every major step that follows! Then if you decide any step has to be redone, you can hopefully avoid going back to the beginning.



Cropping

I’ve talked about how, when taking a picture, you need to fill the frame with only what is essential. But often the photographer didn’t do that, so you need to crop while editing. Other reasons might be that you want to refine the composition further, or you need to change the shape to fill a certain space, or you just need to use less of the photo to keep the important part from being displayed too small.

When cropping for composition, Photoshop’s Crop Tool offers greater convenience and flexibility than the Marquee Tool and Crop command. In the Crop Tool options, select a standard ratio to get easy-to-manage proportions. In Photoshop CS, if you uncheck “Delete Cropped Pixels,” you can always select the tool again, restore the deleted area, and make a different crop.



Contrast, Brightness, Tint

Often, a few quick adjustments can make a dramatic improvement in picture quality, especially on scans. Photoshop CS includes several automatic commands for this on the Image menu—Auto Tone, Auto Contrast, and Auto Color—while Photoshop Elements offers similar commands on the Enhance menu. You can experiment with these to see if you like what any of them does. But since they’re cumulative, apply only one at a time, and undo that step before trying another.

If you’d like more direct control, you can use the Levels command. Photoshop CS places this under Image > Adjustments, while Photoshop Elements places it under Enhance > Adjust Lighting. One advantage of this command over others is that it displays a histogram—
 a graph of the tones in your picture. This can help you adjust more precisely. The dialog box looks like this in Photoshop CS6:
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For a picture with good contrast, the histogram curve will reach from one end of the graph to the other, indicating a full range of tones. A picture with weak
 contrast will normally fall short at one or both ends—as in the example above.

Improving the picture is easy. Just drag the sliders from left and right to meet or slightly overlap the ends of the curve. By setting the white point
 and black point
 in this way, you spread out the tones to take up the full available range. After that, you can also drag the middle slider to darken or lighten the midtones, making the whole picture look brighter or darker. Make sure the Preview box is checked through all this, so you can see the effect on the picture.

After adjustment, the dialog box might look like this:
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Of course, not all
 pictures should be handled this way. If you have a photo taken in fog, for example, it won’t have and should not
 have high contrast. In this case, you would leave the curve concentrated in the middle of the graph. Similarly, the curve for a picture of a field of snow should stay largely or entirely to the right.

•

As you can see, the Levels dialog box also has a set of eyedropper tools. You can set the white point, for example, by selecting the white eyedropper and clicking a spot in the picture that should be fully white. While using the right slider may be simpler, the eyedropper has one advantage: It also balances the color. So, if your picture has an unwanted tint, or color cast,
 the eyedropper may get rid of it.

If there’s no spot in your picture that should be fully white, you can try balancing the color with the gray eyedropper instead. In a full-color picture, neutral grays are produced by blending equal amounts of the three RGB colors. So, if you click a spot in the picture that should
 be neutral gray, Photoshop will use that to balance all color in the picture. Finding the right spot to click, though, can be tricky, so you might have to try different ones till you see the right results.

•

The kind of editing described in this section can also be done in a Raw editor like Adobe Camera Raw (a Photoshop add-in), Adobe Lightroom, or Apple Aperture—and in fact, Camera Raw is where I currently do most of it myself. Nowadays, such editors can handle TIFFs and JPEGs as well as Raw files.

The biggest advantage to Raw editing is that it’s a simple way to edit nondestructively.
 Instead of changing the pixels in your original picture, it just saves instructions on changes to make to any version you export. And you can change those instructions whenever you want, either during that editing session or anytime in the future. You no longer have to worry about doing something you can’t undo, or having to start over, or making a backup after each major step.

Still, handling pictures is trickier in Raw editors than in pixel-based ones like Photoshop, and describing a set of alternate techniques is beyond the scope of this book. So, if you’d like to further explore this option with one of Adobe’s offerings, I suggest you look at Jeff Schewe’s The Digital Negative
 or one of Martin Evening’s guides to Photoshop or Lightroom.



Sizing

Much of the advice you read about picture size—even in Amazon’s documentation—is outdated, because it is meant for Kindles with relatively low resolutions. High resolution is now the order of the day, and many Kindle users want to be able to zoom in on a picture as well.

There are still reasons to keep pictures small: limited memory in many Kindles; slow, expensive downloading over cellular networks; and Amazon’s per-megabyte download charge when you’ve chosen the 70% royalty option. But strictly from a quality standpoint, you want to aim large. In a picture with important detail, a larger size will always show it off better, either in the screen’s native resolution or when you zoom in.

Meanwhile, if a picture is too big to fit on a particular Kindle’s screen, that Kindle will just shrink it down—not cut off part of it, as you may sometimes hear. (Though large pictures can get cut off, it’s not because of size—it’s because the picture was placed in an indented paragraph. This shifts the picture to the right after
 shrinking, which can push the right edge past the margin.)

If you decide to go small anyway, note that Amazon’s guidelines set minimum dimensions of 300 × 400 pixels for a photo. There is no minimum for other picture types.

•

The key to formatting a picture for maximum quality—as well as for consistent relative size on all Kindles—is to format it for a high-resolution tablet.

For instance, say I have a picture I want to extend across the full width of the Kindle’s content area (the area between margins)—a maximum of about 5 inches on an iPad. I’ll assume a screen resolution of 288 ppi—a convenient number that lies between Amazon’s recommended 300 ppi and the resolution of most tablets today. That gives me a content area width of 5 × 288, or 1440 pixels. (The number 288 and its multiples are “convenient” because they’re divisible by 72, 96, 16, and 12—significant numbers in computer graphics and processing. JPEGs, for instance, are compressed in sets of 16 pixels.)

So, I would size this picture to 1440 pixels wide. With this sizing, each Kindle will now shrink the picture to fit, while showing it as wide as possible and at the highest available resolution. Here’s a sample:
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For a picture you don’t
 want at full width between margins, the same trick will work, but with an added step. This time, let’s say I want the picture to be roughly one-fifth
 as wide as the content area. I start by sizing the picture to 288 pixels wide—1 inch at 288 ppi. Then I pad
 it on the sides, bringing the width up to the full 1440 pixels—again, 5 inches at 288 ppi. Now, no matter what Kindle it appears on, the picture will be about one-fifth
 as wide as the content area.

To achieve this in Photoshop, use the Canvas Size command to extend the picture with blank areas to left and right. Here’s the dialog box in Photoshop CS6:
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The added areas can be left blank, but if the Kindle user then switches to Night mode or Sepia, the white might look too much like a mistake. So, a better idea might be to fill the areas with a color that complements the picture. Or, if your picture is destined to be a GIF, you can make these areas transparent, letting the background show through. Because of the way a GIF compresses the picture, you can add almost any size area of transparency or solid color without increasing file size much at all. (I’ll describe later how to add transparency.)

Here’s a sample of a picture at a more or less consistent one-fifth
 width, with transparency added.
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•

To really make an impression with a picture, or to show fine detail, you’ll want to make your picture fill as much of the Kindle’s content area as possible. For that, you need to consider not only width but also aspect ratio—
 the proportion of width to height. To fill the content area, you would ideally match the aspect ratio of your photo to the aspect ratio of the Kindle’s content area. Any difference would make your picture fall short of the margins either vertically or horizontally.

Unfortunately, this ratio varies widely among different Kindles—roughly from 3:4 on e-ink
 Kindles and iPad to 5:8 on Fire HD. A rough average, though, is 2 to 3. So, to have your photo displayed as large as possible overall, you should not only manage the width but also try to crop it to 2:3 dimensions.

•

We’ve been talking so far as though we could size our pictures as large as we’d like, but that’s not really true. Your own software may impose a constraint. For instance, Microsoft Word limits pictures to 22 inches (55+ cm)—and when you export from Word to HTML, that’s at 72 ppi for Mac or 96 ppi for Windows. (More on that later.)

But at this writing, the most important constraints are likely to be the ones in Amazon’s Kindle converter. For comic books, the maximum file size for an individual picture is 800 KB; for a picture in other kinds of fixed-layout Kindle books, it’s 256 KB. But for pictures in flowing text—the Kindle’s most common format, and the one we’re focusing on here—the converter allows only under 128 KB!

If, for instance, you submit a JPEG that’s 128 KB or larger, the converter will first try to bring it under the file size limit by compressing the picture to within an inch of its life. If that’s not enough, it will do that plus
 reduce the picture’s pixel dimensions. If the original pixel dimensions have been specified in your HTML—as most programs, including Word, will do automatically—the converter won’t change that specification in the code. But that means, even though your picture will be displayed at the specified size, its resolution will be lower than you wanted.

By the way, if you’re wondering how Amazon came up with the number 128 for its kilobyte limit, it’s 2 multiplied against itself six times—a convenient way of figuring for a computer. Another tidbit: When figuring file size, the converter rounds upward
 to the nearest kilobyte. (Don’t ask me how long it took to determine that.)

Even if your file size is within the limit, your JPEG may not be safe from interference. Though Amazon doesn’t tell you this, the Kindle converter also analyzes each JPEG to make sure it has been compressed at least as much as Amazon thinks suitable. If the quality level is deemed too high, the picture is compressed further—whether it exceeded the file size limit or not!

And what about GIFs? A GIF under the file size limit will be left untouched. But a GIF over the limit will first be converted
 to JPEG and then suffer the same fate!

Yet another constraint applies to the file you submit to Amazon KDP—the Zip archive you send, containing all your text and pictures together. Though there may be no absolute limit to its size, Amazon warns that conversion may slow down or fail if your submission is over 50 MB. That recommended limit is fairly high, but you could still hit it in a book containing numerous pictures.

•

Given the continuing introduction of Kindles with pixels more and more densely packed, it’s likely that Amazon will eventually ease up on these restrictions. But for now, what do they mean in practical terms for a photo or painting destined for JPEG?

For at least some of these, to avoid heavy, destructive compression, the total area needs to be limited to about half a million pixels (height × width). Others, with less detail, can go to about a million pixels with no great harm. Meanwhile, the content area of Amazon’s highest-resolution Kindle is over four million!

Does that mean JPEGs can never fill the screen of a high-resolution Kindle? No, because—as I’ll show you later—you can tweak your HTML code so that pictures expand to reach the margins. But it does mean that, when you do fill that screen, you can’t take full advantage of its resolution. That’s Amazon engineering!

Let’s take the example of a 2:3 photo to see how to make a picture as large as possible within these constraints. There are actually several ways to do this: the easy way, the best way, and the middle way.


The easy way.
 Simply submit your JPEG in the largest dimensions you have, at the highest quality (least compression), and let the Kindle converter resize and compress it automatically. The converter will leave it as large as possible, and if you’re lucky, it won’t look bad—at least not before you zoom in.

Besides the simplicity of this approach, it has the benefit that you won’t need to reformat your pictures if Amazon ever allows larger file sizes. All you’ll have to do is process your book files with the updated Kindle converter.

On the other hand, this approach may create a problem if you have a series of photos meant to have a consistent look, since your photos could easily wind up displaying at different resolutions. In fact, if at the same time the pixel dimensions are not specified in your HTML, the photos could even show at different sizes. Another possible problem is that a number of such JPEGs may send you over Amazon’s recommended limit of 50 MB when you collect your files for submission.

Following is a photo formatted the easy way. The photo contains a high amount of detail and was sized 14 × 21 inches at 72 ppi—so you can be sure it has been both resized and heavily compressed by the Kindle converter. Note that I’ve optimized my HTML code to cause the photo to expand to the margins on newer Kindles, if necessary. I’ve also added a page break before it—partly to avoid quirky sizing by older Kindle software for iPad, and partly just for effect.
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If you are reading the Kindle version of this ebook, you’re seeing the image as it was actually compressed by the Kindle converter. If you’re reading a print or PDF version, you’re seeing an emulation of a past conversion. If you’re reading an EPUB or iBook version—sorry, you’re probably just seeing the original. No one else compresses like Amazon!


The best way.
 This is the way for people like me, who want maximum quality as well as maximum control. It means optimizing each photo yourself, individually. This can be done conveniently in Photoshop’s Save for Web dialog box. Here’s another look at that dialog box in Photoshop CS6:
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In Photoshop CS, choose 2-Up
 view to show the modified image and file size side-by-side with the original. Then, in either CS or Elements, follow these steps:

1. Set the JPEG Quality to 50. This setting is apparently low enough to avoid the Kindle converter’s undocumented quality cap.

If you’re not using Photoshop, note that this number is just how Photoshop chooses to designate a certain level of the particular compression techniques it applies. Even if another program shows the same scale of settings, they won’t mean the same, and 50 might be too high or too low. To determine that, you would need to test your results, using tools I’ll describe later. Or you could skip this step and accept that the Kindle converter may compress your files more.

2. Make sure you’ve selected the “Optimize” option to reduce the size a bit further. Don’t worry about this making your JPEG “less compatible,” as Photoshop puts it—that’s only a concern with ancient software. The “Progressive” option might reduce size further still, but the JPEG might then slow down some Kindles.

3. Check the final file size shown under the preview. If the picture hasn’t cleared the Kindle converter’s limit of 128 KB, lower the Quality setting till it does; or else use the Optimize to File Size command on the pull-down menu at top right.

The final file size shown by Photoshop is only an estimate, and the file that’s actually saved will probably be a bit larger. So, for safety, give yourself at least a few kilobytes of leeway in the dialog box, then check the resulting file. For instance, with the Optimize to File Size command on the Mac, I specify 118 KB instead of 128.

4. Look at the preview at various magnifications and compare it to the original. Some amount of degradation is expected and acceptable, since it will be less visible when the picture is displayed at smaller sizes. But if there’s too much, reduce the pixel dimensions and set Quality higher.

You’ll learn with experience to judge how much degradation is all right. In general, though, I would try not to set Quality lower than 30%—Photoshop’s default for Medium—and I’d especially avoid settings below 20%. Even one percentage point lower than that will mean sharply reduced quality, as it forces a switch to a more severe compression method. (The Kindle converter, left to itself, can go as low as the equivalent of around 5%!)

If you need to reduce the file size a bit, but you don’t want to change the quality or dimensions of your picture, you might instead try reducing detail in the original—cropping more tightly, reducing “noise,” sharpening less, or slightly reducing contrast. Any of these will produce a smaller JPEG.

If you get really
 desperate, you can omit the color profile from the JPEG, which can save up to several KB. This won’t affect your Kindle book, since the Amazon converter strips out the profile anyway.

Even after optimizing manually, you will probably still
 get some file size reduction from the Kindle converter—maybe as much as 10 KB—but this is less likely to come from recompression as from stripping away unused resources like embedded metadata and any color profile.

The following photo was optimized manually. It’s the same size as the last one was initially—14 × 21 inches at 72 ppi—but because this one has much less detail, I could let it stay that big. Meanwhile, I compressed it to JPEG in Photoshop’s Save for Web dialog with a Quality setting of 40 and “Optimized” on, for a file size of about 114 KB.
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As another example of manual optimization, here is a cartoon caricature of yours truly. The dimensions are 12 × 15 inches at 72 ppi. This too has a Quality setting of 40 with “Optimized” on, for a file size of about 126 KB.
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The middle way.
 This simply means you control one or more parameters—at least partially—while leaving the rest to the Kindle converter. For example, your main concern might be to prevent the Kindle converter from reducing your pixel dimensions. In that case, you could first limit the area of all your photos to about half a million pixels—for instance, in our 2:3 example, by making them all 576 × 864 pixels. It’s not likely the converter would then need to reduce these dimensions further as part of reducing file size. Again, save the photo as a JPEG at highest quality (least compression).

Or, if your book has many pictures, you might be concerned about the collective size of all the graphics. A number of uncompressed JPEGs might make your book awkward to handle, or even put it over Amazon’s 50 MB limit on submission size. In this case, you might decide to apply mild compression to your JPEGs, knowing the Kindle converter will apply the rest later. Just by switching from Maximum quality to Very High in Photoshop’s Save for Web, you can greatly reduce file size without doing much harm.

•

To bring an oversize GIF under the 128 KB limit, you have fewer options than with a JPEG. If you leave it to the Kindle converter’s processing, you won’t even have a GIF anymore—it will be converted to JPEG. So, there’s no “easy way.”

As for optimizing manually, the size of a GIF file varies so much with picture complexity that it’s much harder to make general statements about file size and dimension limits. Basically, you just have to experiment.

The first step, though, is to try to reduce the number of colors in your picture. This will produce a more efficient, and therefore smaller, GIF file. A GIF can never
 allow more than 256 colors—that’s why it’s no good for full-color photos and paintings, which need many more colors than that to display properly. But the kind of pictures suitable for a GIF may not even need 256.

For instance, if your picture is supposed to be a single solid color, the GIF only needs to display two—that single color, plus white or transparency for the background. Even if your “single-color” picture has edges that are visually smoothed by antialiasing
 —a process that adds intermediate shades—the GIF shouldn’t need to display more than 32 colors, and possibly no more than eight.

Reducing the allowed number of colors in a GIF is a simple matter of choosing a lower number from a menu when you save the file. But be aware that not all pictures will benefit. Say, for example, that a computer-generated picture has exactly sixteen colors. Reducing the colors allowed
 in your GIF from 256 to sixteen will have little or no effect on file size, because no additional colors were in use anyway.

On the other hand, if that same picture has been printed out and scanned, it will probably be chock full of minutely varied shades just aching to be discarded. The file size of such a GIF can probably be lowered dramatically with no ill effect. If anything, the color may improve by becoming more uniform.

As with JPEGs, the Photoshop Save for Web dialog box makes it simple to adjust a GIF. Here’s the same dialog box when GIF format is chosen:
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In 2-Up
 view, just select the lowest number in the Colors pull-down menu that avoids generating a visual difference between the preview and the original—or go a little lower, if you need to.

For a GIF at a borderline size, Photoshop’s various options and settings can be lifesavers. Among color reduction methods, the default Selective is generally best, but you can try others. Dithering is for smoothing the picture’s color transitions but also increases file size and can often be left off without harm. The Interlaced option should always be off. At low settings, Photoshop’s unique Lossy option may significantly reduce file size without substantially hurting quality.

If these measures don’t bring your GIF under the limit, you’ll just have to reduce the pixel dimensions, or else see if you can do better with JPEG.

•

Since file size reduction is so important in preparing pictures for Kindle, you might wonder whether you should turn to a specialized image compression tool or plug-in for best results.

If you’re using Photoshop or Photoshop Elements, the answer is no. Save for Web is about as good as it gets, and you’re unlikely to find anything that surpasses it. Apps that claim to give higher quality at even smaller file sizes may be counting on your not knowing how to use more sophisticated tools or not knowing how to judge the results.

You can test this yourself (as I have). Compress a JPEG with a specialized app, then another with Save for Web with settings that yield about the same file size. Then compare the two at 100% magnification.

JPEG compression involves throwing away picture information. Significant reductions in file size come from throwing more away. There is no free lunch.

•

As I said, the Kindle converter’s constraints are likely to become more lenient in later versions—the current file-size limit is already twice as high as the original. If you’re not choosing the easy way to size your pictures, you’ll want to keep up with things, so you don’t wind up doing more harm than good. But meanwhile, Amazon seems to be more cagey about letting you know what those constraints are, with most mentions of them removed from recent versions of the Kindle Publishing Guidelines.

To keep up with current limits, then, you should probably not rely on Amazon’s documentation. I’ll try to report important changes, for those who check my Publishing Blog or sign up for my email list. Again, that’s all at


www.newselfpublishing.com


Possibly an even better source of alerts is R. Scot Johns. Sign up to follow Scot’s Blog at


authoradventures.blogspot.com
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Update!



In the previous section, I advised that Amazon’s file size limits would likely become more lenient. That is now what has happened.



In fact, as it turns out, it happened some time before Amazon revealed it—which even then was with nothing more than confusing hints. Since February 2014, new versions of the Kindle Publishing Guidelines have talked in some places about a 5 MB limit instead of the former 128 KB—but in other places seemed to say that the lower limit was still in force.



So, here’s the real story, as finally revealed in May by Amazon KDP staff in private correspondence: Pictures exceeding the 128 KB limit are still resized and/or compressed for Kindles that have lower resolutions—and for now at least, according to my testing, also for Kindle apps on iOS. But for Kindle tablets with higher resolutions, the books are sent with image files at original size, up to 5 MB each! (According to my KDP source, this change came with version 2.9 of KindleGen, the Kindle converter—almost a year earlier!)



What this means is that your internal JPEGs should now be submitted at high resolution, without regard to the 128 KB limit. But you should also apply a moderate amount of compression on your own, so your readers don’t receive needlessly huge files. In the Save for Web dialog of Photoshop or Photoshop Elements, I recommend a Quality setting of High, or 60%.



GIFs are a different story. Though the Kindle converter can competently reduce the size of most JPEGs, its method of reducing a GIF is to convert that to a JPEG too—and that seldom works well. So, for the sake of all owners of lower-resolution Kindles, I recommend sticking to the 128 KB limit for your GIFs.



You may wonder how all this affects minimum pricing and download fees for your Kindle books. Well, that’s one of the reasons this stayed hidden for so long. It seems that Amazon still bases those on the smaller

 size. For example, if you were to submit a book in reflowable format with twelve pictures at 2 MB each, it would be delivered to higher-resolution Kindle tablets in a file of about 24 MB. Yet your minimum pricing and delivery fee would be based on the size of the file sent to lower

 -resolution Kindles—about 1.4 MB!



Thanks, Amazon, for finally allowing a reasonable image file size for high-resolution tablets. But would it really have been so hard for you to explain all this from the start?
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Sharpening

Near the end of the editing process, few pictures are as sharp as they could be. The original camera shot may not have been in perfect focus, or the lens may have been weak. Scanning always softens a picture a little. And when you resize a picture by resampling, it usually becomes fuzzier.

To counteract all of these, the picture is normally sharpened as a final or near-final step of editing. That is, the picture is made to appear
 sharper—it’s actually an optical illusion produced by increasing the contrast at edges. In Photoshop CS, the simplest, most effective way to manage it is with Smart Sharpen on the Filter menu. In Photoshop Elements, find the same command as Adjust Sharpness on the Enhance menu. Here’s the dialog box in Photoshop CS6:
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Though the dialog box includes a small preview, selecting “Preview” lets you see the approximate effects on the picture as shown in the editing window. So, before even calling up Smart Sharpen, zoom the whole picture to 100% so you can see what’s happening at the lowest level.

In the dialog box, set the amount of sharpening high enough to make picture details stand out but not high enough to make the whole thing look “crunchy”—a common error of beginners. The higher the ultimate display resolution, the higher the amount of sharpening the picture can tolerate. For Web graphics, I generally use 25%; for print, 100%. For the pictures in this ebook, 50% seemed about right—except on the screenshots, which I didn’t sharpen at all, to avoid unsightly artifacts.

You can also experiment with the settings for blur type and radius, or just leave them as is. As a guideline, pictures with more detail can benefit from a radius under 1.0, while pictures with less detail do well with one higher.

Photoshop CC has a more advanced version of Smart Sharpen, which provides more adaptable sharpening with fewer artifacts. In fact, it’s one of the main reasons I broke down and got a subscription from Adobe! This advanced sharpening did not make it into Photoshop Elements 12, but hopefully it will be in the next version.



Transparency

The Kindle supports GIFs that include transparency, which lets you see right through parts of a picture to whatever lies behind. This is something you might want, for instance, when your picture is an irregular shape that leaves a blank area between the picture and its rectangular boundaries. You could
 just leave such areas pure white, but then they would look bad if the Kindle is switched to Night or Sepia color mode. If the areas are transparent instead, the background color will show through.

A transparent background can be especially useful for doohickeys you use to head chapters or to divide sections within them. Just make sure the doohickey itself isn’t black, or Night mode will make the entire picture disappear! If the picture is to have just a single color, choose one with a medium lightness to show up best in a variety of color modes.

•

Photo editors differ in how they let you create transparency. In Photoshop, start with the Layers panel. (If you don’t see it, select it from the Window menu.)

Most of the time, this panel will show a single layer, called “Background.” You can’t create transparency on this layer, because anything you remove is replaced by the color white. But you can convert the layer to a fully editable “Layer 0” just by double-clicking on it, there in the panel.

Next, select the area you want to be transparent. Normally you’ll do this by selecting all of the picture’s surrounding white. The tool for this is the Magic Wand. (In Photoshop Elements, find it by clicking on the Quick Selection Tool then selecting the Magic Wand in the Tool Options bar.) For this task, you’ll usually want a Tolerance of 1 or another low number, with “Contiguous” turned on. Also make sure “Anti-alias” is off, since the smoothed edges it produces look whitish in Night mode.

Now, just delete the selected area. It will be replaced by—nothing at all! On screen, you will see the area filled with a checkerboard pattern, like this:
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If you resize the picture after that, you want to avoid smoothing the edge. So, choose the “Nearest Neighbor” method of resampling instead of “Bicubic.”

Finally, call up the Save for Web dialog box and save as a GIF. The Transparency option must be checked, and in the pull-down menu just below that, “Diffusion Transparency Dither” must be selected. The areas of the picture you deleted will then be fully transparent on Kindle.



Lines and Letters

For Kindle publishing, special challenges are presented by line drawings and other pictures featuring strong lines and edges—and especially the complex strokes of letters and other text characters. Of course, some of the most popular types of pictures on Kindle have such strong lines or letters or both. These types include cartoons, comics, tables, graphs, charts, diagrams, maps, and screenshots.

So far in this book, we’ve talked mostly about pixel-based pictures, technically called bitmapped.
 (Yes, I know, the word bitmap
 gets used in all too many ways.) And many pictures with lines and letters are likewise based on pixels. But others are based instead on vectors.
 That means they’re made up of mathematical formulas that the digital device translates into pixels only when it’s ready to display them. This allows the device to optimize the picture for the screen, and it also allows smaller picture file sizes.

In fact, that’s how text type too is normally handled. The text you’re reading on your screen right now is just a series of vector pictures of letters and numbers. That’s why it looks so much better than text in pictures based on pixels.

The ideal way to handle vector drawings would be to leave them as vectors. Amazon tries to make this possible for the Kindle by accepting a picture format called Scalable Vector Graphics (SVG). Like PDF, SVG can incorporate both vector drawings and bitmapped pictures within it. SVG is supported by illustration programs like Adobe Illustrator, Microsoft Visio, and Inkscape.

Unfortunately, only newer Kindles can display SVG pictures. If you want your vector drawing to be seen on all
 Kindles, you must first convert it to pixels—which can be tricky to do well.

•

The chief trouble with pictures that have strong lines and letters is that any pixelation is more apparent than it would be in a photo or painting with continuous tones. This pixelation shows up on slanted lines and edges as jaggies
 or stairstepping
 . Here’s a magnified view of what those jaggies can look like on 24-point
 type at 72 pixels per inch.
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Now, here’s the same text at 288 ppi. Though you can still see the jaggies in this magnified view, they’re unlikely to bother you much at normal viewing size. If they’re noticeable at all, it will be only as a slight roughness.
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For text, then, you want to start with as many pixels in the picture as you can. Higher resolution will make your edges display less roughly when scaled to the Kindle screen.

Another method that can complement or substitute for maintaining higher resolution is antialiasing.
 This gives the impression
 of smoother edges by filling in the stair steps with grays or other intermediate shades of color. Here’s how it looks on that 24-point
 type at 72 ppi.
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This is roughly how your computer would display these letters on your monitor—though Windows would throw in a little extra color, just to uglify it a bit. For the Kindle, though, we can do better than this by combining
 antialiasing with higher resolution. Here’s antialiasing on the text at 288 ppi, where it pretty much removes any roughness noticeable at normal viewing size.
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There are some costs and drawbacks to antialiasing. First off, since it uses intermediate tones, you can’t antialias a picture in bitmap color mode. The picture must be in grayscale or RGB, requiring a larger file size.

Also, antialiasing is able to smooth edges only by blurring them, making them less sharp and distinct—an effect you can only partly reduce by sharpening. This is especially a problem at lower resolutions. (Which is one reason your eyes grow tired when you spend too much time at your computer.) Sometimes you have to judge whether this fuzziness isn’t a bigger problem than the jaggies it’s meant to suppress.

Finally, antialiasing is best done for new
 pixels. For a picture in pixels already, it’s possible to add some antialiasing by blurring or by resizing with a Bicubic method. But the chief and most effective use of antialiasing is when a vector drawing is first converted to pixels. Also, the converted picture benefits most from antialiasing when it doesn’t need later resizing. In other words, you should try to specify the picture’s final pixel dimensions at the time of conversion, not later. The lower the resolution, the more this matters.

Besides displaying poorly at low resolution, lines and letters are strongly degraded by JPEG compression. This makes distinct edges look dirty with a kind of artifact often called “mosquito noise.” The lower the picture resolution, the more obvious the effect. Here’s what medium compression looks like on that 72-ppi
 antialiased type.
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To avoid this, try to stick to higher-quality levels of JPEG compression—or better yet, switch to GIF. If you do need substantial JPEG compression for your picture, try at least to avoid or minimize sharpening before that. The more sharpening that has been applied, the worse the JPEG artifacts.

To summarize, then, we want our lines-or-letters picture to be high-resolution—possibly with antialiasing, if we can do it effectively—and have minimal or no artifacts from JPEG compression.

Now let’s look at some specific examples of how these guidelines can work with real-world pictures. Though I can’t cover every possible scenario, these cases will hopefully provide enough options that you can adapt the methods to anything you might encounter.

•


Case study #1: Bitmap line drawing, from a scan.
 For a line drawing, you can’t get any simpler than pure black and white in bitmap color mode. It might come from a scan, or you might create it in Photoshop or another photo editor.

The picture in this example is the cartoon caricature you saw before, but this time without the coloring. It began as a pen-and-ink sketch of about 5 × 6 inches and was scanned at 1200 ppi. This is generally a good resolution when preparing a picture for print—but at those linear dimensions, there were too many pixels for either the Kindle converter or Word. So, I had to reduce the picture, winding up with 1296 × 1584 pixels.

To compensate for the lower resolution, I added some smoothing by converting from bitmap to grayscale ahead of time and using the Bicubic method to resize. Then I compensated for the smoothing by applying Photoshop’s Smart Sharpen filter at 50%. I then saved the sketch as a GIF with 32 colors, for a file size of about 95 KB.

It looks like this:
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•


Case study #2: Vector diagram, from Adobe Illustrator.
 Diagrams are often created as vector drawings. They’re typically produced in a program like Adobe Illustrator, Microsoft Visio, or Inkscape, though simple ones can be done in InDesign, Word, or even PowerPoint.

This example was created in Illustrator at a size of 5 × 1.5 inches. (Vector drawings have no native resolution.) To prepare it for Kindle, I converted to GIF with Illustrator’s Save for Web & Devices command.

On the Image Size tab, I specified 1440 × 432 pixels. Also on that tab, I chose the type of antialiasing from the unlabeled pull-down menu at bottom left—“Type Optimized” was my choice for this one. And I clicked the Apply button to display the picture with those settings in the preview. After magnifying the preview, I reduced the number of colors in the GIF to the lowest I could go without seeing a difference, which was 16. I wound up with a file size of about 3 KB.

And here is the result:
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The Save for Web & Devices command gave me exact control of final size and resolution, but I could have used the Export command instead. In this case, I would have exported to TIFF, specifying my preferred type of antialiasing (if any) and a resolution that would provide enough pixels for me at the document’s linear dimensions. Then I would have brought it into Photoshop and used Save for Web to create the GIF.

•


Case study #3: Sample form, from Microsoft Word.
 Sometimes what we want to insert in an ebook might be not just a small piece of content but an entire page, shrunk down. For this example, I created a picture from a one-page
 sample form laid out in Word.

To prepare, I replaced the form’s Palatino typeface with Georgia—a sturdier serif face that looks decent in print but was specially designed by Microsoft for low-resolution display on the Web. This makes it superior on any screen and at small sizes. Though I could have gotten an even cleaner look with a sans-serif face like Verdana or Arial, that would have altered the look of the form too drastically. (Also, just switching to Georgia required little reformatting, since its character widths closely match Palatino’s.)

Lines and text are both handled within Word as vectors, and unfortunately, Word offers no way to export these as pixels. So, the next thing I had to do was get the page out of Word, which I did by saving it as PDF. In Word for Windows, I could have done that directly, but on the Mac, I had to use the Print command and that dialog’s PDF button/menu.

With a PDF, I could then use Photoshop for the conversion. On import, Photoshop CS6 immediately asked how I wanted the PDF converted to pixels. The settings I entered said I wanted the picture cropped to the “media box” (to retain margins), antialiased, resized to 17 × 22 inches (exactly double the original dimensions) at 72 ppi, and converted to sRGB. (With Photoshop Elements 11, I could have specified the same, except it always crops to the “bounding box,” removing margins. To restore them, I would have enlarged the picture with the Canvas Size command.)

Here’s what the Photoshop dialog box looked like:
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With the picture open in Photoshop, the text appeared on top of the checkerboard of transparency, which I didn’t need or want. I got rid of it by going to the pull-down menu at top right of the Layers panel and choosing “Flatten Image.” (I could have instead just unchecked the Transparency option in Save for Web.) I also used the Rectangle Tool to draw a border around the entire picture, to enforce the impression of its being a page.

With no further ado, I used Save for Web to create a GIF of 32 colors at about 105 KB. And here it is. Note that it’s easily readable if you zoom in.
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This approach—exporting a PDF and converting in Photoshop—also works well for content from Adobe InDesign, which is handy for creating diagrams and book cover images but lacks the export capabilities of Illustrator. It works best, though, if you’ve already defined the black type in your InDesign document as RGB instead of CMYK. If Photoshop has to convert the type from CMYK, you might not wind up with pure black.

•


Case study #4: Table, from Microsoft Word.
 Though newer Kindles can display tables just fine, older ones can’t do it well or at all. So, Amazon recommends that you find another way to display your information, and that if you can’t, you produce your table as a picture.

Our example here is a simple table produced in Word. I could have handled this the same way as my sample form—saving to PDF and converting in Photoshop—and then followed up by cropping to size. For variety, though, I did this one with a screenshot—a picture of the screen.

My first step was to change the font of the table text from Georgia to Arial—from a serif font to a sans-serif. This gave me cleaner, sturdier lines, for better display at smaller sizes and lower resolutions.

I then made the table as large as possible on my computer’s display. I maximized the document window to fill the screen, then magnified the view in Word to 500% so my table nearly reached the window edges. This gave me high resolution and also antialiasing, since Word antialiases what it displays on screen.

I also turned off the display of invisible characters like spaces and paragraph marks. Normally, you would do this just with the Show/Hide button—the one that looks like a paragraph mark—but in my case, I needed to change some View preferences as well.

To “capture” the screen on my Mac, I used the OS X utility Grab, which allowed me to take a TIFF picture of a single window. But I could instead have taken a PNG picture of the entire screen just by pressing Command-Shift-3
 . In Windows, you would use the Snipping Tool if you had it, or just press the Print Screen key on your keyboard.

After bringing my TIFF into Photoshop, I flattened the image, then magnified the view and cropped to the black borders to get rid of white edges that would look bad on the Kindle in Night or Sepia mode. (If the screenshot had been taken on Windows, I would also have switched color modes from RGB to Grayscale to get rid of the horrid colors Microsoft uses for antialiasing.) I resized to 1440 × 486 pixels. Then I used Save for Web to produce a GIF with 32 colors, for a file size of about 25 KB.

And here it is:
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•


Case study #5: Screenshots, from Mac OS X.
 For the previous example, I used a screenshot to convert Word content to pixels. Sometimes, though, what you want to show isn’t the content of a document but the interface elements of a program or operating system. So, the screenshot itself becomes the content.

But even though software elements contain lines and letters, these aren’t made from vectors as such content usually is. Instead, they’re designed in pixels that are carefully matched to the low resolutions of most computer displays. As soon as you break the correspondence between display resolution and picture resolution—as you should for your Kindle book—you face a challenge. If you’re not careful, you can wind up with extreme pixelation, heavy blurring, or excessive artifacts.

You’ve already seen examples of my screenshots throughout this book. As with my example of the Word table, all of these were initially captured as TIFFs with the Mac OS X utility Grab. Now I’ll explain how I processed them—which was with a fair amount of trial and error.

To preserve a clean look for Web graphics, screenshots are traditionally made into GIFs. This was the approach I tried first. As preparation, I resized my screenshots in Photoshop CS6 to 1008 pixels wide (14 inches at 72 ppi), using the Nearest Neighbor method to preserve hard lines. But the result was a picture that could not be zoomed without showing heavy pixelation. Here’s a magnified view:
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I next tried resizing with Photoshop’s Bicubic method. That smoothed out the type considerably, but it also increased the GIF file size. To still fit it under the Kindle converter’s limit, I had to sharply limit the number of colors—and that led to banding in the gradients used for the top bar and buttons. (E-ink
 Kindles will always
 show banding in such gradients, because of their limited levels of gray, but color Kindles shouldn’t.) Here’s what it looked like:
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At this point, I decided I’d better switch to JPEG. This is what I got:
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Better! And certainly acceptable at normal viewing sizes. But it bothered me to see that the type edges were somewhat degraded by oversharpening—even though I wasn’t sharpening at all!

The culprit was Photoshop’s Bicubic method. Because this method softens edges, Photoshop adds automatic sharpening—and there’s no way to turn it down or off. (Despite a confusing name, Photoshop’s Bicubic Smoother method adds more
 sharpening than regular Bicubic. It is “smoother” only in relation to Bicubic Sharper.)

I resolved this by turning to Perfect Resize (formerly called Genuine Fractals), a Photoshop plug-in and standalone program from onOne Software.


www.ononesoftware.com


Using a different enlargement formula, Perfect Resize maintains cleaner lines with less need of sharpening. Here is my final result, taken from the image used in this book:
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Better still! So, is this the solution I’d recommend?

Unfortunately, no. I have since learned that Perfect Resize installs Nalpeiron, a third-party anti-piracy program from ProTec, which has been know to cause problems on both Windows and Macs. You cannot regulate it, and it does not uninstall with Perfect Resize. So, until onOne stops including Nalpeiron or similar software, I recommend you avoid
 Perfect Resize! (To remove Nalpeiron from a Mac, delete the ProTec folder in /Library/StartupItems. Note that this also disables Perfect Resize.)

An alternative, though, has arrived from Photoshop itself—specifically, from Photoshop CC, the online-subscription successor to CS6. The new version offers an improved resampling method for enlargement called “Preserve Details.” Though this option did not make it to Photoshop Elements 12, I suspect it will also appear in that program eventually.

Here’s what I was able to do with “Preserve Details” in Photoshop CC.
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As you can see, Photoshop is still
 sharpening heavily but now manages to keep edges much cleaner while doing it. At the same time, the antialiasing is better than in any of the other enlargements, so that lines are smoother and more distinct. While not perfect, the look is certainly one I could live with.

But what I’m really
 waiting for is what has been coming with the Retina Displays that Apple has introduced into its Mac line, starting with laptops. Photoshop CS6 and Word 2011 have already been updated for this display, and Photoshop Elements should follow suit eventually. This updating means software elements are redesigned at double the resolution! (Windows 8 too enables high-resolution viewing, and screens to support it have now started to appear.)

Though I’ll need new hardware and software before I can upgrade all screenshots in this book, OS X versions since Snow Leopard have offered an experimental mode for limited high-resolution viewing on normal monitors. (If you’re interested, search on “HiDPI Mac.”) So, I was at least able to capture for you the following teaser. Easily better than anything I’ve shown you yet, it’s a magnified view of a screenshot minus any enhancement at all!
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4

Picture Handling



Positioning

There are two basic ways to position a picture in a document. The first is in line with text.
 This generally means inserting the picture in a paragraph—usually a paragraph of its own, with no text. The picture then moves up or down automatically as you add or remove text in the paragraphs above it. The second way is to make the picture float.
 This allows you to place it anywhere you want on the page and have it stick there, with your text flowing and wrapping around it.

By default, most word processors position a picture in line but allow you to float it as an option. Page layout programs reverse this, floating the picture by default but also letting you place it in line. In HTML—whether exported from a program or created manually—a picture will be in line unless made to float by an align property in the image tag, or else by a CSS float property.

Though the Kindle’s newer Format 8 allows either method of positioning, older Kindles display pictures only
 in line. So, I suggest you forget floating and text wrap and just keep your pictures in paragraphs from the start.

•

When you insert a picture in a paragraph, the kind
 of paragraph is important. It must not be indented, either on its first line or as a whole. If it is, some Kindles will simply shift your picture to the right without adjusting its size—and on a picture meant to stretch between margins, this can make its right edge disappear past the margin!

Unfortunately, leaving the paragraph with no indent is trickier than it should be, because Kindles indent paragraphs by default—and in some cases, even if you’ve specified the opposite! The best way to avoid automatic indenting is to center
 the paragraph. The Kindle will then respect the lack of indent.

•

I spoke before of padding the sides of a small picture to keep its size proportional to the page width. You could use the same trick to position the picture off-center horizontally. Simply add unequal padding to the sides.

The following picture should appear one-third
 of the way from the right margin.
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•

To most impress with a large picture, you’ll want to set it on a page by itself. When composing your book in a word processor, the simplest way to do that is to position page breaks before and after.

This approach can leave a good deal of blank space on the display of a Kindle Fire, with its skinny aspect ratio that’s optimized for movies. And there is unfortunately no good way to center the picture vertically on the page. For such reasons, you might be tempted to forgo the page breaks. Surely it’s better to let text fill up the space!

The problem is, when displaying picture and text on the same page, some older Kindles will shrink
 the picture a bit when that makes it fit space remaining at the bottom. If you care to avoid this, you need a page break at least before
 the picture.

You’ll need to be careful how
 you add any page break. For instance, if you’re working in Word, do not
 insert a manual page break or section break. When exported to HTML, these will add a bit of blank space at the page top on some Kindles. Though it’s only a line or so, it may be enough to cause the Kindle to push the picture to the next
 page, creating a blank page between.

Instead of inserting a manual break, format the paragraph containing the picture with the setting “Page break before.” This will start a new page without adding space. If you want a page break after
 the picture as well, apply that same formatting to the following paragraph.

You’ll also have to watch out if you have two or more full-page pictures in a row. In this case, you do not
 need to specify a page break between them—you’ll get one anyway—and even a “Page break before” setting for the second picture may cause older Kindles to insert a blank page between.

•

One major problem the Kindle presents is how to make sure a caption stays with its picture. The sad truth is, there’s no good way to do it in a book with flowing text.

I suggest you avoid the problem entirely by replacing the caption with a picture description in the main text. (“The following picture shows . . .”) Or place your caption before
 the picture with a reference to it following. (“Below: My picture.”) Or if you’ve positioned page breaks before and after the picture, you can place a caption on the previous or next page, while adding a reference to that effect. (“Next page: My picture.”)

If you’re determined that a caption be viewed on the same page as its picture as often as possible, limit the picture to an aspect ratio of 4:5 or shorter, either by cropping or by padding the sides, and then position a page break in front of it. Also, put the caption in 10-point
 type and tuck it tightly under the picture, with no space between the two paragraphs.

Or, if you’re really desperate, add the caption to the picture itself in your photo editor. But text added this way will never look as good as the rest of your text.



Pictures in Word

Probably the most popular workflow for creating Kindle books—and the one recommended by Amazon itself for beginners—is to compose the book in Microsoft Word and export to HTML, the language of Web pages and ebooks. When the book is exported, pictures are saved in a separate folder with links to the main HTML document.

Word, though, has a bad tendency to tamper with pictures, and how it does that can vary wildly from one Word version to the next. Your best bet is to handle your pictures in such a way that Word simply lets them pass through, with no change whatever. The following tips should ensure this, as well as make sure the picture is properly positioned in your Kindle book.

•

In your version of Word, locate the Web Options and make sure the following is deselected
 : “Allow PNG as an output format.” (Oddly, the Web Options setting for picture resolution has no effect.)

In most cases, add only JPEGs and GIFs. Any other format will be converted to one of these anyway, but you won’t be able to control how Word does it.


JPEGs must be 72 ppi for Mac or 96 ppi for Windows.
 A GIF, on the other hand, is by definition always
 72 ppi—but Word for Windows treats it as 96 ppi anyway.

For both JPEG and GIF, stay within Word’s maximum picture size of 22 inches (55+ cm) on a side. At 96 ppi for Windows, that’s 2112 pixels. At 72 ppi for the Mac, it’s 1584.

•

To add a picture, use Word’s command to insert it from the file. Do not
 drag or paste it in. For safety and convenience, make sure the insert dialog is set to actually insert the picture rather than “Link to File.”

To repeat
 a picture, you should copy and paste within the document instead of inserting again. With this method, Word may output the picture only once, with multiple links to it—though Word’s behavior in this is inconsistent from one version to another.

Place the picture in a blank paragraph with “Single” line spacing, centered, with no indent for either the first line or the whole paragraph.

Make sure the image is “in line with text”—Word’s default—rather than “floating.” That means you must ignore Word’s options to let text “wrap” around the sides of your picture or appear in front or behind it.

•


If Word shrinks the picture to fit within your document’s margins, the picture will be exported with reduced pixel dimensions.
 Specifically, the new pixel dimensions will be the new linear dimensions at 72 ppi for the Mac, or 96 ppi for Windows. In addition, if that picture is a GIF, some versions of Word will convert it to JPEG
 .

I know some readers will be tempted to skip over this because it sounds too technical, but please take my word for it: You can’t afford to ignore this.
 In fact, for anyone producing a Kindle book with pictures in Word, this may be the most important tip you get from this book!

As an example, let’s say you import a GIF that’s 2112 pixels wide and 2112 pixels high into Word 2010 for Windows, in a document that’s 7 inches between the left and right margins. Word will automatically shrink the picture to fit that 7 inches. Then, later, it will export the picture as a JPEG, and at 96 ppi for the reduced
 size, giving you final pixel dimensions of 672 pixels each way. In other words, your picture will wind up with about a tenth
 of its original pixels, and in a different format, to boot! Much of your careful work of picture editing and optimizing will have gone down the drain.

To prevent that resizing and format conversion on export, call up the dialog box that controls the picture’s size. Where you find it will depend on your version of Word, and there will be more than one way to reach it. In Word 2010 for Windows, you can click or double-click on the picture to bring up the Picture Tools, then click the bottom-right icon on the Size command group. On the Mac, you can select the picture and then access the dialog box from the Format menu. On either Windows or Mac, you may also find it by right-clicking or Option-clicking on the picture. Here’s the dialog box in Word 2004 for Mac.
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Now uncheck
 “Lock aspect ratio,” then click “Reset.” Both of the scaling dimensions should now show at 100%. If the dialog box in your Word version lacks a Reset button, type in these scaling dimensions directly.

When you click “OK” and return to the document, you’ll see the picture appropriately enlarged and extending past the right margin—awkward but manageable. What’s more important is that Word will now export it at its original pixel dimensions.

The procedure I’ve described is needed when working in any view for print documents—views called Print Layout and Draft in recent Word versions and Page Layout and Normal in older ones. (Pictures are invisible, though, in Draft View for .docx files.)

As an alternative, in recent Word versions, you can switch to Web Layout. In this view, pictures are inserted at 100% size, and they stay that way when you switch back to other views. (An earlier version of this view, Online Layout, did not work this way.) In fact, Web Layout is not a bad view for editing Kindle books, especially with pictures—except it will not show your added page breaks.

A couple more notes on sizing: Do not
 apply a border to your picture in Word—a border of any width will change the scaling and trigger resizing. Also, if Word displays your JPEG as smoothed and fuzzy, this does not
 mean the picture itself has been touched.

•

Though a GIF with transparency is best created in your photo editor, you may find it simpler to start with your picture in a different format and add transparency in Word itself—for instance, adding it to a TIFF at the preferred 72 ppi for Mac or 96 ppi for Windows. With transparency added, Word will output the picture as a GIF, regardless of original format.

How the transparency command is accessed will vary among Word versions, but in newer ones, click or double-click the picture to call up the Picture Tools. Then select Recolor > Set Transparent Color, and click on white in the picture, or on any other color you want transparent. For the procedure in older versions, search Word Help for “transparency.”

•

If a picture is meant to fill all or most of a page, do not
 add a manual page break or section break before it. In some cases, this can cause the Kindle to display an entire blank page before the picture! Instead, you can apply the setting “Page break before” to the containing paragraph.

If you have two full-page pictures in a row, though, don’t apply this setting for the second
 one. It isn’t needed—you’ll get the page break anyway—and on older Kindles, this too can generate a blank page.

•

The procedure for exporting to HTML will vary according to your version of Word, but you’ll be saving as “HTML” or “Web Page” or the like. In the dialog box that comes up, you then want to specify the variety that includes the least
 code. This may be designated as “Web Page, Filtered” or by an option like “Save only display info into HTML.” In either case, you’ll be choosing to omit code that isn’t proper HTML and that could be used only by Word in reimporting the document. If in doubt about which option to choose, save in alternate ways, then choose the one that creates the smallest
  file.

After export to HTML, check the picture files to make sure they came out as expected!

As an alternative to keeping Word from tampering with your pictures, you could replace Word’s outputted picture files with your own versions. For more than a few pictures, though, this may be tricky, because Word renames
 them—with names like “image001.jpg,” “image002.jpg,” and so on, based on their order of appearance. Any time you add, remove, or move a picture within your ebook, this also changes the output filenames of pictures placed after that one.



Pictures in HTML

Though you don’t need to know HTML to work on pictures on Kindle, it can help in some ways. I’ve included this section for those who already know some or who hope to explore it. For more help, see my book HTML Fixes for Kindle.


•

In the HTML for your Kindle book, pictures are inserted in the text by means of an image tag (<img>). Minimally, it might look something like this:

<img src="image01.jpg" width="576" height="864" alt="">

As in this example, it’s common to provide a picture’s pixel dimensions within the tag. This is considered good practice, as it speeds up page rendering. For older Kindles, though, it has even more importance, because it prevents quirky picture handling. Without these stated pixel dimensions, the Kindle might automatically enlarge a small picture to the point of pixelation; or the text under a larger picture might be pushed unnecessarily to the next page.

Note that older Kindles can read the dimensions only
 in bare-bones HTML format, as shown above. Dimensions in CSS format—as may be written by some ebook creation software—will be ignored. The example above, but with the kind of CSS dimensions you don’t
 want, would look like this:

<img src="image01.jpg" style="width: 576px; height: 864px;" alt="">

•

If file-size constraints keep your pictures from filling the content area of a high-resolution Kindle, you can benefit from a different way of specifying size.

To force a picture to display as large as possible on newer Kindles, use CSS to specify a width of 100% and a height of “auto”—or a width of “auto” and a height of 100%. Either way simply tells the Kindle to expand the picture as needed to fit between margins. If the picture is already big enough to need no expansion, the instruction has no effect.

To modify your code, place the following style attribute inside the picture’s image tag. Note that the quotes, as in all HTML and CSS tags, are straight, not “smart” or “curly.”

style="width: 100%; height: auto;"

You can simply add this attribute to the tag, leaving the HTML dimensions in place. After modifying our earlier example, it might look like this:

<img src="image01.jpg" width="576" height="864" style="width: 100%; height: auto;" alt="">

You could also entirely replace
 the HTML dimensions with the style attribute—but as I said, removing those dimensions can cause quirky behavior in older Kindles, so I don’t recommend it.

Misinterpreting Amazon’s vague guidelines, Kindle designers sometimes skip the CSS and simply specify an HTML image width of 100% to handle both older and newer Kindles. Though image size percentages are allowed in older HTML versions, the current version considers this an error—and in any case, older Kindles still can’t use them. It may appear
 these Kindles are reading a percentage when the picture is enlarged—but enlarging is just what they do when they get no dimensions at all. And they’re still enlarging quirkily.

Of course, any enlarging to the margins leaves a picture displaying at a resolution lower than its original one. But if, as I’ve recommended, you start with as many pixels as possible, the picture will still look fine, and you’ll gain more in increased size than you’ll lose in lower resolution.

•

Microsoft Word is oddly prone to introducing HTML errors in its image tags. These errors are ignored by the Kindle converter, so there’s no great need to fix them. But if you want to anyway—say, to keep a syntax checker from reporting them—it’s easy enough to do.

If you’re exporting from the old .doc format—Word’s native format in any version before 2007—add the following empty attribute anywhere within the tag. (Those are two straight double quotes, with no
 space between.)

alt=""

If you’re exporting from .doc and
 are on a Mac, your image tags will have a problem also with their ID attributes, which will all look something like this:

id="_x0000_i1025"

ID values are not supposed to start with an underscore, so just remove that.

If you’re using the newer .docx format, on Mac or Windows, the ID attributes will have a different problem. You’ll see them numbering the pictures, starting like this:

id="Picture 1"

The ID value should have no space within it, so just remove the space from between “Picture” and the numeral.

Or for either problem with the ID attribute, you can just remove the attribute entirely. It serves no useful purpose in your Kindle book.

By the way, if you do use a syntax checker on Word’s HTML, set it to check for “HTML 4.01 Transitional.” Otherwise, the checker will report multitudes of errors that aren’t there!



Fixed Format

Up to now, we’ve been talking mainly about the best way to handle pictures meant to illustrate a text. But what if the pictures are equally important or even more so than the text? That might be true, for instance, in a book of photography, or in a children’s picture book.

For such books, Amazon gives you the choice of publishing in fixed format.
 Instead of letting text and pictures flow on the page according to screen size and user settings, you pin them in place to create static page layouts. You then no longer have to worry that pictures and text won’t appear in proper relative positions. You can even keep captions where they belong!

Maybe even more important, Amazon allows larger file sizes for pictures in a fixed-format book. At this writing, the general limit is 256 KB—twice the size allowed for pictures in books with flowing text. But for fixed-format books designated as comics—in which each image is assumed to be a full page—the limit is 800 KB! These higher limits allow much higher picture quality. (Reportedly, though, the higher limits are allowed only for JPEGs, not GIFs.)

Still another advantage is that your pictures are allowed a larger display area. With flowing text, they’re constrained within the margins set for the page. But in fixed format, they can fill the screen from edge to edge.

Of course, these advantages come at a price. With larger file sizes, Amazon will either deduct higher download fees from your royalty or, with a different royalty scheme, restrict how low your book can be priced. Also, fixed-format books won’t work on all Kindles, and Amazon will automatically restrict their sale to owners of suitable ones. In some cases, this restriction may even be stricter than needed. (If so, Amazon may later relax it, especially if you request that.)

All of that’s not to mention the challenge of sizing the type so it’s legible on small Kindles but not overblown on large ones!

•

To produce a fixed-format book, you’ll need specialized software—unless you are well-versed in HTML and/or willing to study a lot. (If you are, I doubt you’ll find a better guide than How to Make Kindle Comics & Children’s Books
 , by R. Scot Johns.)

The best general tool for fixed format may be Jutoh 2, which in early 2014 was available as a preview. Find it at


www.jutoh.com


A simpler but surprisingly versatile program is the Kindle Comic Creator. While Jutoh uses HTML coding to keep text and pictures in place, the Comic Creator simply exports each page as a single picture. The Comic Creator, as well as other Amazon tools for Kindle, can be found at


www.amazon.com/kindlepublishing
 
or




www.amazon.com/kindleformat


Despite the program’s name and the internal designation of “comic” in the saved Kindle book, there’s nothing that limits the program to creating comics. My own first uses of it were for illustrated children’s books and a book of poetry in which text positioning was crucial.

The genius of the Comic Creator is that you don’t need to compose your pages in the Comic Creator itself—in fact, its capabilities in that area are severely limited. Instead, you import pages you’ve composed in just about any other
 program. That program could be for photo editing, or illustration, or word processing, or page layout, or even slideshows. No matter how your pages are produced, the Comic Creator will turn them into a Kindle book for you within minutes.

The Comic Creator will accept JPEG; TIFF, which is converted to JPEG; and PNG, which is converted to JPEG or GIF. (Oddly, GIFs cannot themselves be imported, at least in the current version of the Comic Creator, and neither can SVG.) Most remarkably, it will also accept PDF, either single- or multi-page. PDF pages are converted to JPEG in their original linear dimensions at 300 ppi.

•

The flexibility of the Kindle Comic Creator lets it support a variety of workflows—but as a single example, here’s what I did with the second book I produced from it, The Legend of Lightning Larry
 .

The general procedure was to export a PDF from InDesign, import it into the Comic Creator, then export a Kindle book. That’s basically it. But the details for this case were more complex than most people would encounter, because I started with a file prepared for a print edition. With 48 pages at 6 × 9 inches, it was composed with 16-point
 CMYK type, plus TIFF illustrations in the Adobe RGB color space.

To start, I went back to my InDesign file and cropped a half inch off each side margin and three-quarters
 inch off both top and bottom, making pages of 5 × 7.5 inches. The Kindle doesn’t need margins as wide as in a book, and they would have forced the text to display smaller. You’ll note, though, I cropped to retain the original 2:3 ratio—and you’ll remember that this is the ratio I gave earlier as the best compromise for filling Kindle displays.

Since the book’s illustrations had originally been laid out to bleed off the 6 × 9 page, I scaled these down within InDesign to fit the new width. I also made sure each page could stand alone, so it would never be necessary to view two at a time at a smaller size.

All my colors needed converting to the sRGB color space, and I had more than one way to do it. The easiest way would have been to specify the conversion in InDesign’s PDF export options. This would have worked fine for my Adobe RGB illustrations, but it would have turned my pure black CMYK type to a very dark RGB gray. (Not that anyone would have noticed the difference, but it’s one of those purist things.)

The first solution I adopted was to export the color with no change and then use the Convert Colors command in Adobe Acrobat Pro. This let me take advantage of the command’s “Preserve Black” option, guaranteeing pure black RGB after the conversion. Later, though, I decided there was a better way. I went back to my InDesign file and assigned all black type to a pure black RGB swatch (0-0-0
 ) instead of pure black CMYK (0-0-0-100
 ). This allowed me to safely convert the black to sRGB on export.

In the Comic Creator, I set up my new book with the required metadata and these settings: no Kindle Panel View, orientation unlocked, and a canvas size of 800 × 1200 pixels. The setting for canvas size—which Amazon equates with “original resolution”—can be confusing, because it really only determines aspect ratio. The pixel dimensions of my pages, when rendered from PDF to JPEG by the Comic Creator, were actually 1500 × 2250.

This new-book setup took a minute or so, and after that, importing my PDF and exporting as a Kindle book took another couple of minutes. Yes, it can really be that easy, once your pages are ready to go. As for the advanced features offered by the Comic Creator for making comics, I simply ignored them.

•

As I said, the Comic Creator exports your PDF pages as images at 300 ppi. To get the full benefits of that high resolution, make sure each picture in the PDF is at that same resolution or higher. That won’t be a problem when exporting from most programs, but versions of Microsoft Word starting with 2007 have had a bad habit of stealthily downsampling pictures—not only for HTML export, but also for PDF export and printing.

For example, Word 2007 and 2008 won’t export or print pictures at a resolution higher than 220 ppi and may also degrade them in other ways while they’re at it. Word 2010 and 2011 are better but will still downsample your pictures unless you tell them not
  to.

To do that in Word 2010 for Windows, go to File > Options > Advanced > Image Size and Quality, then check the option “Do not compress images in file”—or, as it might be expressed, “Kindly keep your stinking hands off my pictures.” This will set a general preference for all files. To specify this for the current file only, access the option “Use document resolution” on the ribbon under Picture Tools through the ironically-named command Compress Pictures. Make sure you un
 check “Apply only to this picture.”

Word 2011 for the Mac offers “Keep Current Resolution” as part of the equally ironic “Reduce File Size” on the File menu. Make sure you apply it to “All pictures in this file.” There’s no way to set this as a general preference, so you must set it again for each file or include it in a template.

•

Though pages with more pixels will give you higher display quality, you should keep an eye on file size. For a book giving you 70% royalties, you’ll be paying a per-megabyte delivery fee—currently 15 cents. With 35% royalties, Amazon won’t charge that fee but also won’t let you set your price below a certain minimum—currently $2.99 for 10 MB or more, and $1.99 for more than 3 MB.

Note, though, that these fees and minimums are not
 based on the size of the book file produced by the Comic Creator. That file includes not only the actual Kindle book but also a set of working files generated by the Kindle converter—so it’s about twice the size of the file that will actually be delivered to Amazon customers.

To find out the “deliverable” file size, look in the Comic Creator’s Console window once your book is generated. The last few lines will show deliverable size for both the old Mobipocket format (“standard Mobi”) and the newer Kindle Format 8 (“KF8”), the two Kindle formats now supported by Amazon. Though Amazon sends to each Kindle only the format suited to it, the bulk of the book will be in the pictures, which will be the same for each format—so the two sizes shown in the Console will be roughly the same. (They will be given in bytes instead of megabytes, so just divide by 1,000 for a rough figure.)

What can you do if the size is greater than you want? Unfortunately, there’s no recourse within the Comic Creator itself. But if you don’t mind the work, you can always import your pages as JPEGs with higher compression—keeping in mind the quality you’ll lose.

Or, if it’s a PDF you’re importing, you can scale down its page size. Depending on your software, you might be able to do that when you generate it, or even later. For example, on Windows, a PDF already created can be scaled with Adobe Acrobat Pro. Here’s the procedure for Acrobat Pro 9 on Windows 7:

Open your PDF in Acrobat Pro, then choose the Print command. For the name of printer, choose Adobe PDF—a virtual printer installed by Acrobat Pro. For Page Scaling, choose “Fit to Printable Area.” Do not
 select “Choose paper source by PDF page size” or “Print to file.”

Now click the Properties button next to the printer name. Go to the Paper/Quality tab and click the Advanced button. For Page Size, select “PostScript Custom Paper Size.” Then set the page dimensions you want. (If there’s a way to save these settings for the Page Setup dialog, I don’t know what it is.)

After approving your settings and making your way back to the Print dialog, you should see your new dimensions specified in the preview. You can then go ahead and “print” to Adobe PDF, which will produce a new PDF file at the page size you’ve set.

If you’re on a Mac, the procedure is a bit
 simpler. Here it is for OS X Snow Leopard:

Open your PDF in Preview—generally, double-clicking the file will do this—then choose the Print command. For Paper Size, choose “Manage Custom Sizes” (assuming you haven’t already added your desired size to this menu).

Add a new size called Untitled by clicking the plus sign. After clicking and holding a second or two on that name, type in a new one that will identify it to you later. Now change the Paper Size dimensions to the ones you want and delete
 all the margin settings or enter zeros.

After approving your settings and returning to the Print dialog, you should see your new page size in effect with scaling already set up. Then just use the PDF button/menu to Save as PDF.

By the way, this scaling trick also works in reverse, as I discovered with my book of poetry. Converting from a print edition, I wound up with 12-point
 type on landscape pages of 5.25 × 3.75 inches. To raise the eventual pixel count, I scaled these up in Preview to a page size of 7 × 5.

No matter what you do, you may find that the deliverable file size of a book from the Kindle Comic Creator is simply too big. For example, the first children’s book I created with it—The Adventures of Mouse Deer—
 came out around 16 MB, as I could not reduce it further without compromising the display quality of the text. With either Kindle royalty scheme, the lowest price Amazon let me set for that book was $2.99—and as I found out, that was simply too high for its market.

I wound up converting the book to flowing text so I could price it more attractively. Later, I may try it in fixed format again but in a program allowing more control over file size, or maybe even in raw HTML. In fact, I may do the same with Lightning Larry
 .

•

The Kindle Paperwhite tends to be an odd duck in how it displays Kindle books, and this is certainly true with books from the Comic Creator. Alone among all Kindles, the Paperwhite will crop off blank edges to the extent of reducing the pixel dimensions as much as about half, and then enlarge the remainder of the page to fit the screen!

This means that any margins you’ve left around your content are likely to disappear—and if they aren’t symmetrical, your content may shift horizontally or vertically. Also, if the size of your content area varies from page to page, your content may display at a variety of magnifications. In other words, your book may look less than professional!

There are various ways you might prevent this cropping. You could add a background image—even just a solid color. You could add non-white borders, at least at your top and bottom edges. You could place small ornaments at top and bottom. Or headers and footers.

In the end, though, any attempt to make your book look better on the Paperwhite is likely to make it look worse elsewhere—and maybe even on the Paperwhite. So, you may just want to accept the handicap, while hoping that Amazon eventually wises up and fixes this.

Another problem with the Paperwhite is its response to a Kindle book with locked landscape orientation. On the Paperwhite, orientation is governed by a menu setting that applies to all
 books. When the Paperwhite opens a book locked to landscape, it changes its own menu setting automatically—and the user may not know how to change it back!

Besides that—as I can tell you from personal experience—a locked landscape book can make the Paperwhite unresponsive to the point that you can’t call up commands or exit the book! So, all in all, I strongly recommend leaving your book’s orientation unlocked if there’s any chance the book will be read on a Paperwhite.

•

You might think that Kindle for iPad is even quirkier than the Paperwhite if you try testing a fixed-format book on it. That’s because the app handles a standard preview file as a document, not a book—which means Kindle Format 8 won’t be supported. So, testing your book on the iPad requires a special procedure I’ll discuss later.
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Update!



Amazon has now released the Kindle Kids’ Book Creator, an app similar to the Kindle Comic Creator but aimed specifically at children’s books. You can find it at



www.amazon.com/kidsbookcreator



Much of my discussion of the Comic Creator applies to this new app too—but I’m afraid I won’t be able to guide you through the differences, because I’ve abandoned fixed format entirely. In fact, I’ve redesigned and republished all my fixed-format books as flowing text—including the examples discussed in this book.



For me, the balance was tipped decisively by Amazon’s new file size allowances—reported in this book’s update to its section on Sizing
 —along with the growing variety of screen sizes on which ebooks are read. There is simply no way to design a fixed-format children’s book to work well on both iPad and iPhone.



At the same time, I’ve discovered that a surprising number of illustrated books can work in flowing text—if designed or redesigned for that from scratch. For some of my own design solutions, see the children’s picture books I’ve published for Kindle under my Skyhook Press imprint.



Determined to try the Kids’ Book Creator? Look for help on the blog of R. Scott Johns.



authoradventures.blogspot.com
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5

Picture Publishing



Submitting and Previewing

Though submitting and previewing are both essential steps, the order you do them in depends on the tools you’re using. In the simplest workflow, you’ll submit your files to Amazon’s Kindle Direct Publishing (KDP) and then preview the result before going on to publish it. You’ll find KDP here:


kdp.amazon.com


Typically, your pictures will be in separate files that are linked from an HTML document. If so, you need to combine everything into a single Zip archive before submitting. If the pictures are in their own folder—as they will be, for example, after exporting from Word—don’t move them out of it or rename the folder before archiving. If you do, the links won’t work and the Kindle converter won’t know where to find the pictures. Instead, include the entire folder.

To create the archive on Windows, select everything that will go in it, then right-click and choose “Send to compressed (zipped) folder.” Or you can zip just the HTML file and then add the rest to the archive. On the Mac, select it all, then Control-click and use the Compress command, or else find that command on the File menu.

After you’ve submitted your files, Amazon KDP offers you two ways to preview your book. The first is to view it right there online. The online previewer provides a convenient way to check content, and you can set it to emulate various Kindles. But what this previewer actually shows is just a highly-compressed JPEG of each page, making it impossible to judge picture quality. It’s also very slow.

The better way is to download a preview file of your book for testing on your desktop or on real Kindles. This file is close to the book that Amazon customers will receive, but there are a few differences:

• The file lacks digital rights measurement (DRM), so you can easily move it around among different apps and devices for testing.

• The file may open on a different page than the book will, because KDP staff may adjust this location after
 you publish.

• The file includes resources for two separate Kindle formats—old Mobipocket (MOBI) and the newer Kindle Format 8 (KF8)—while the book after sale will contain only the format best suited to the Kindle receiving it.

• The file includes within itself a set of intermediate work files in a Zip archive, approximately doubling the total size. In other words, the “deliverable” file size that determines your delivery fees or minimum pricing will be about half the size of the preview file.

Once the file is on your desktop, you have more than one way to view it. The most convenient is to use the desktop Kindle Previewer, available for Windows or Mac. When KDP offers you a download link for your preview file, it offers one for the Previewer as well. You can also download it here:


www.amazon.com/kindleformat/kindlepreviewer


The desktop previewer is more accurate than the online one and offers more options. Be sure to check your file in different Kindle emulations, available from the Devices menu and then from tabs. Also be sure to check it in Night and Sepia color modes, available for the appropriate Kindle emulations from the Set Font menu on the toolbar. Testing in different color modes is especially important if your pictures include transparency—or if they should.

Of course, the best way to view your file is on Kindles themselves. Though the Kindle Previewer’s emulations are surprisingly accurate—at least for books with flowing text—the pictures as displayed on your monitor will have a different resolution and different color properties. So, the emulations can never look exactly like the real thing.

Obviously, buying a collection of Kindles is a significant expense, but not as great as it used to be, and for serious publishing, you may find it worthwhile. My own collection while writing the bulk of this book included four: a basic e-ink
 Kindle, a Kindle Paperwhite, the smaller Kindle Fire HD, and an older iPad. This book could not have been written without such an assortment.

You can find instructions on the Web for transferring a file to your particular Kindle model after connecting it to your computer. But the simpler, though slower, way is to send it over the Internet with Amazon’s Send to Kindle app. Find it here:


www.amazon.com/sendtokindle


Whatever way you transfer it, note that the file will be treated as a document
 rather than a “book”—so you may need to look for it in a different section of your Kindle.

You should also view your file in one or more of Amazon’s desktop Kindles, found here:


www.amazon.com/kindleapps


These can open your preview file directly, even just from your double-clicking it. But watch out: If you’ve already previewed an older version, your new preview file must have a new name, or else you must delete the old version from the app’s library. Otherwise, it’s the older version you’ll see.

•

Though you can wait till your book is finished before submitting and previewing, chances are you’ll want to test it before that, and possibly many times—especially if you’re working with pictures. Here again, you have choices. First off, you can use Amazon KDP to generate a preview file, just as if you were ready to publish your book, but then hold off on finishing the publishing process. There’s almost no chance of publishing accidentally.

A simpler and more efficient way, though, is with the desktop Kindle Previewer I’ve already discussed. Though the Previewer is primarily used to display
 preview files, it can also create
 them, because the Kindle converter is built right in! To convert and
 preview your Kindle book, you need only drag and drop your HTML document—not a Zip archive—onto the Previewer window. As an added bonus, the Previewer presents a detailed log of the compiling, including any error messages or warnings plus the calculated “deliverable” file sizes of the book in the old “standard Mobi” format and the newer KF8.

If you’re working with the Kindle Comic Creator, you don’t even need the Previewer to create the file. The Comic Creator exports that file directly.

•

One thorny problem has been how to test a fixed-format book—like one from the Kindle Comic Creator—on the iPad. The Kindle Previewer has never supported Kindle Format 8 in its iPad emulation. What’s more, if you send a standard preview file to Kindle for iPad, the file is stored under Docs—and the app’s support for KF8 does not extend to documents.

In the past, this meant that your book preview was displayed in the old Mobipocket format instead of the way it would be for Amazon customers. The only way to test the book for Kindle for iPad was to wait till it was published and then purchase a copy.

Luckily, the situation has changed with recent versions of the Kindle Previewer. If you now select Kindle for iOS from the Devices menu, the Previewer will generate a special file for display on an actual iPad. The Send to Kindle apps won’t handle this file, but you can transfer it via iTunes with the following steps:

1. On the iPad, exit the Kindle app if you are in it. (It may also help to shut down the app entirely, though that’s not supposed to be necessary.)

2. Connect the iPad via its charging cord to your computer’s USB.

3. Open iTunes on your computer.

4. Select your iPad from the items in the sidebar. (If you don’t see the sidebar, choose to show it from the View menu.)

5. Select the Apps tab (at the top, not in the sidebar).

6. Under File Sharing, choose “Kindle.”

7. Import your book preview file by clicking the Add button, or just drag it into the Kindle Documents area. (Weirdly, there’s no command within iTunes to remove
 a document from the list, but you can just select it and press Delete on your keyboard.)

At this point in the procedure, here’s what it would look like in iTunes 11 for Mac:

[image: ]


8. On your iPad, enter the Kindle app.

9. Wait a minute or two. Your book preview should disappear from the Kindle Documents area on your computer and appear on the iPad in the list of Books on the device—not
 Books in the Cloud. (Note that the title might not appear in correct alphabetical order.)

The Kindle app should now be able to display the book preview properly. To remove the file later, simply delete the book from within the Kindle app—not
 within iTunes.

•

With your preview file in hand, you’ll probably want to check your picture files directly one more time, to make sure none have been altered unacceptably.

If you know much about the Kindle format’s main competitor, EPUB, you’ll know it’s actually a collection of files in a Zip archive. This makes it easy to take apart and put back together. A Kindle book too is a collection of files but packaged in a less common format—a Python database. To take apart a preview file—or any other Kindle book without DRM—you need a utility called KindleUnpack (formerly MobiUnpack). It can be downloaded from the first post in this forum thread:


www.mobileread.com/forums/showthread.php?t=61986


KindleUnpack requires that some version of the Python software language be installed on your computer. Macs already have it. For Windows, you can download a free recommended version from this location:


www.activestate.com/activepython/downloads


You want version 2.7 or later—but not
 Python 3, a complete overhaul that is incompatible with many existing scripts.

What you’ll see after unpacking your preview file includes two sets of files and folders for the two different Kindle formats—in this case referred to as “mobi7” and “mobi8.” KindleUnpack will have duplicated your pictures and placed a set in the appropriate folder for each format. Since the two sets of pictures are identical, you only need to find and check one.

Don’t expect the JPEG file sizes to be exactly
 the same as those of your originals. You may see reductions of around 10 KB due to the Kindle converter stripping out embedded metadata or a color profile, with the difference perhaps exaggerated by how data is written to disk. As long as the file size is close to what it was, you probably don’t need to worry.

•

If you’ve created a preview file on your desktop, you have the option of submitting that file to Amazon KDP in place of the files you used to generate it. In fact, when working with the Kindle Comic Creator, that’s your only
 choice.

With this approach, though, you’re more likely to run into a problem of file size. As I mentioned, preview files include a Zip archive of working files that roughly doubles the total size. So, you are much more likely to exceed the 50 MB maximum that is recommended by Amazon to avoid slow or failed processing.

A possible solution for this is to remove
 the archive of working files with a utility called KindleStrip. Download it from the first post in this forum thread:


www.mobileread.com/forums/showthread.php?t=96903


Like KindleUnpack, KindleStrip requires some form of Python on your computer, as discussed above.

Note that KindleStrip was developed for reducing the size of Kindle books for personal use only. Though it seems to work fine for trimming files sent to KDP, the developers don’t endorse it for that, and there is always the chance it could cause trouble—especially since Amazon constantly tinkers with the Kindle converter and its output. Also, the removal of the working files may make it impossible for Amazon to regenerate your book later to fix problems or to benefit from advances in the Kindle format.

That doesn’t mean you shouldn’t use it. But do it only when necessary, and not without checking the forum thread for updates or testing your books thoroughly.

•

Previewing for Kindle is a large topic in itself. To read more about it, see my article at


www.newselfpublishing.com/ProofingKindle.html




Cover Images

In most cases, you will create your book cover image separately from the rest of your book and upload it directly to Amazon KDP in either JPEG or TIFF format. The Kindle converter will then insert the image into your ebook, always as JPEG.

Unfortunately, the converter handles this image the same as any other picture, increasing compression and reducing dimensions to fit it under the file-size limit for that kind of book—currently 128 KB, for a book with flowing text. This is particularly destructive to a cover image, because heavy JPEG compression produces odd-looking artifacts at hard edges—which are more or less what text consists of.

To optimize your cover image for Kindle, then—at least for flowing text—you would provide a 2:3 picture that sticks close to Amazon’s previously recommended minimum
 size of 1000 pixels on the long side—not to its currently preferred 2560 pixels!

•

There’s one problem with that 2:3 aspect ratio, though: The cover image you upload actually does double duty, and its role as ebook cover is the lesser
 of the two. Yes, the image does appear at the beginning of your ebook, but it’s placed before
 the spot where the Kindle opens the book—so most users will never see it there!

The cover image’s more important role is as a promotional image on Amazon—the one that helps customers decide whether to get your book in the first place. For this reason, I suggest you mostly forget
 about optimizing your image for Kindle and instead focus on optimizing it for Amazon. (The exception might be if you have another way to submit cover images to Amazon, letting you use one image in your book but then replace it with another on Amazon’s site.)

And what is the optimum shape for an Amazon cover image? The answer to this used to be easy: a square. All of Amazon’s display areas for cover images were originally in this shape, to accommodate books in either portrait or landscape orientation. A square cover image would then take best advantage of the area available. (That’s why Amazon chose this shape for the cover images of its Amazon Shorts.) Given that shape, my recommendation for a Kindle cover—with exact dimensions adjusted for quality and efficiency—would be 1008 × 1008 pixels.

Starting in 2013, though, Amazon has experimented with a new book page design. So, while most of Amazon’s cover image display areas are still
 square, there’s one big exception: the slot for the main image on this experimental book page—when it appears. That one has a ratio of 3:4!

For now, I suggest sticking to the square. But you should keep an eye on Amazon’s display spaces, to see whether at some point you’d be better served by the newer ratio or by something between old and new.

•

At these kinds of pixel dimensions—unless your image is extremely simple—don’t even try to bring it under the file-size limit of 128 KB. Instead, give Amazon your image as a JPEG with little or no compression, or even as a TIFF. For online display, just as on the Kindle, Amazon will compress it unmercifully, but it will do that no matter what you submit—so it’s best to start off with a clean image.
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Production FAQ


What program did you use to put this book together?


This book was composed in Microsoft Word 2004 for Mac, with HTML tweaking in BBEdit. The choice of Word, though, was inspired more by familiarity and research needs than by the program’s capabilities.


What software did you use for the pictures?


Most final editing was done in Adobe Photoshop CS6, with some later revision in Photoshop CC. For initial photo editing, I used Camera Raw, an Adobe add-in to Photoshop. Some graphics were created in Adobe Illustrator.


How did you produce the screenshots?


The initial captures were done with Grab, a utility included in Mac OS X. I resized them to 1008 pixels wide—14 inches at 72 ppi—in Perfect Resize, a Photoshop plug-in. (But I no longer recommend Perfect Resize, because of its installation of Nalpeiron, intrusive and problematic anti-piracy software from ProTec.) I then used Save for Web to export and optimize them as JPEGs.


How did you create your book cover?


My book cover was created in Adobe InDesign; exported to JPEG at maximum quality with antialiasing; resized and sharpened as needed in Photoshop; then again exported to JPEG with Save for Web, including sRGB conversion and profile embedding.

Because of different size requirements and format optimizations, the covers for the Kindle and EPUB versions of this book are different. The Kindle version is square, with 1008 pixels each way. The EPUB version is 3:4, with 1500 × 2000 pixels.


Who painted the portrait on your book cover and title page?


Wendy Edelson, illustrator of my children’s picture books The Baker’s Dozen
 and Christmas Truce.
 Find her at


www.wendyedelson.com



Who created the cartoon caricature of you?


The original ink sketch was a gift from Toni Goffe, illustrator of my children’s picture books The Legend of Lightning Larry
 and The Legend of Slappy Hooper
 . Find him at


www.tonigoffe.com


It was later colored by Angelo Lopez, a library assistant, for a poster advertising an author visit of mine.


Who took the photos?


I did! You can see more of my photography on Flickr, at


www.flickr.com/photos/aaronshep
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MORE BOOKS FOR YOU
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From Word to Kindle


Self Publishing Your Kindle Book with Microsoft Word, or Tips on Designing and Formatting Your Text So Your Ebook Doesn’t Look Horrible (Like Everyone Else’s)

By Aaron Shepard
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HTML Fixes for Kindle


Advanced Self Publishing for Kindle Books, or Tips on Tinkering with HTML from Microsoft Word or Anything Else So Your Ebook Looks as Good as It Possibly Can

By Aaron Shepard
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The Business of Writing for Children


An Award-Winning Author’s Tips on Writing Children’s Books and Publishing Them, or How to Write, Publish, and Promote a Book for Kids

By Aaron Shepard
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The Legend of Lightning Larry


Story by Aaron Shepard

Pictures by Toni Goffe
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The Adventures of Mouse Deer


Favorite Folktales of Southeast Asia

Told by Aaron Shepard

Pictures by Kim Gamble
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The Baker’s Dozen


A Saint Nicholas Tale

Story by Aaron Shepard

Pictures by Wendy Edelson
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Baking with Cookie Molds


Secrets and Recipes for Making Amazing Handcrafted Cookies for Your Christmas, Holiday, Wedding, Party, Swap, Exchange, or Everyday Treat

By Anne L. Watson
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Aaron Shepard’s


Sales Rank Express


Quickly Check Amazon Sales Rank and Much More for Print Books, Kindle Books, and Audiobooks on Amazon Sites in Most Countries with the Premier Sales Rank Checker for Authors, Publishers, and Other Book Creators and Marketers




www.salesrankexpress.com
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Picture Book Texts Available

The Legend o{; Li%htning Larry. Original tale of a gunfighter with a huge smile and
a gun that shoots bolts of light instead of bullets. Can Larry save the town of
Brimstone from Evil-Eye McNeevil's outlaw gang?

The Legend of Slugpy Hooper. Tall tale from Depression-era Chicago of the world’s
biggest, fastest, bestest sign painter. Trouble 1s, he’s too good—his pictures keep
coming to life.

The Gifts of Wali Dad. Indian and Pakistani tale of a humble grasscutter who tries
again and again to give away unwanted wealth—only to receive ever-greater
wealth in return.

The Baker’s Dozen. Legend from colonial America about a self-righteous baker
who gets a lesson in generosity from an old woman and Saint Nicholas.

The Enchanted Storks. Classic Middle Eastern tale of a caliph of Bagdad and his
xgiziﬁr who try a spell that changes them into storks, then find they can’t change
ack.

Master Man. Nigerian tale of a man who boasts he is the strongest in the world—
until }l;\le meets the real strongest man. Will he end up as dessert, or can anyone
save him?

Mop Top. Norwegian tale of a wild princess and her wilder adventures. Babies
grow on trees, troll girls cavort, heads pop off, and butts are bopped.

The Boy Who Wanted the Willies. A Grimm brothers tale of a ridiculously fearless
boy in"a thoroughly haunted castle. Will he ever get the willies?

The Lady of Stavoren. Dutch le%end of how the arrogant pride of a rich lady

merchant—and her quest for the most precious thing in the world—brought ruin
to a prosperous seaport.
Kings for Breakfast! Tall tale from India of one king who grants every request, and
another who is fried, eaten, and magically restored daily to earn gold for the
poor. Which of them is more generous?

Please send the manuscripts indicated.

Not interested, because

EDITOR:

HOUSE:

AS@aaronshep.com » www.aaronshep.com
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